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Syllabus 

BBA- SEC 301 IT Tools for Business 

Course Objective: The purpose of this course is to provide a through exposure to the operating and 

office management tools available in different packages. A student can be exposed to the working 

knowledge of Windows based operating systems and software packages such as Windows-95, 98, 2000-

Professional, windows -XP and MS -Office. 

Course Outcomes (COs): After completion of the course, the students shall be able to: 

CO1: Develop understanding of computer fundamentals, functions and their classifications 

CO2: Develop a clear understanding and knowledge about the functioning of a Computer software and 

window operating system 

CO3: Demonstrate proficiency in Microsoft word & Excel. 

CO4: Apply formatting and editing features to enhance worksheets. 

CO5: Use styles, themes, and conditional formats to customize worksheets. 

Unit –I 

Computer Fundamentals: Data, Instruction and Information, Characteristics of Computers, Various 

fields of application of Computers, Input-output Devices (Hardware, Software, Human ware and 

Firmware) Advantages and Limitations of Computer, Block Diagram of Computer, Function of 

Different Units of Computer, Classification of Computers. Data Representation: Different Number 

System (Decimal, Binary, Octal and hexadecimal) and their Inter Conversion. 

Unit –II 

Computer Software: Types of Software, Application software and system software, Compiler and 

Interpreter, Generations of languages, Low- and High-Level Languages. Computer Memory: Primary 

Memory & Secondary memory. Storage Media. Introduction to Windows Operating System: All 

Directory Manipulation: Creating Directory, Sub Directory, Renaming, Coping and Deleting the 

Directory File Manipulation: Creating a File, Deleting, Coping, renaming a File Using accessories such 

as calculator, paint brush, CD player, etc 
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Unit –III 

MS-Word: History, Creating, Saving, Opening, Importing, Exporting and Inserting document, 

Formatting pages, Alignment, Paragraphs and Sections. Indents and Outdents, creating lists and 

numberings Formatting Commands: Headings, Styles, Fonts and Size Editing, Viewing Text, Finding 

and Replacing text, Headers and Footers, Inserting page breaks, Page numbers, Special Symbols and 

Dates Mail merge, Preview and Printings command. 

MS-PowerPoint: History, Creating, Saving, Opening, existing presentation, Creating and Saving a 

Presentation using Auto Content Wizard, Design Template, Blank Presentation the Slide Sorter View, 

Slide Show, Inserting pictures and graphics and Printing Slides. 

Unit –IV 

MS-Excel: Introduction, Components of Excel History, Creating, Saving, Opening, Spreadsheet, 

Formatting numbers and Text, Graph and Chart Formatting Commands, Menu Bar, Toolbars, 

Producing Charges, Protecting Cell Macro and Printing Operation, Spell Checking, Cell Editing, 

Calculation of various Financial and Statistical Functions using Formulas. 

Note: Relevant Case Studies should be discussed in class. 

Suggested Readings: 

 Ram, B.(2018).Computer Fundamentals Architecture and Organization. New Delhi: Age Publications 

 Sinha, P.K. and Sinha, P. (2017).Foundation of computing. New Delhi: BPB Publications. 

 Arora, A.(2015) Computer fundamentals and applications. Vikas Publishing. 

 Rajaraman, V.(2014).Fundamentals of Computers. Delhi: Prentice-Hall. 

 Roger,J. (2010).MicrosoftAccess2010.Delhi:PearsonEducation. 

 Forouzan,(2009).Basics of Computer Science. India: Cengage Learning 

 Levi, D.S., Kaminsky, P. (2007) Designing and Managing the Supply Chain. McGraw Hill 
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 Topics   

Sr. No. UNIT – I  Pages No 

    1 Computer Fundamentals: Data, Instruction and Information, 

Characteristics of Computers 

       5 - 6 

    2 Characteristics and Various fields of application of Computers       10 - 11 

    3 Input-output Devices (Hardware, Software, Human ware and 
Firmware) 

       11- 18 

    4 Advantages and Limitations of Computer,        18-  21 

    5 Block Diagram of Computer, Function of Different Units of 
Computer, Hardware & Software 

       21 - 25 

    6 Classification of Computers        25 - 28 

    7 Data Representation: Different Number System (Decimal, Binary, 
Octal and hexadecimal) and their Inter Conversion. 

        28 - 39 

 UNIT II  

    8 Computer Software: Types of Software, Application software and 
system software, Compiler and Interpreter 

        39-42 

   9 Generations of languages, Low- and High-Level Languages         43-45 

  10 Computer Memory: Primary Memory & Secondary memory Storage 
Media 

        46-47 

  11 Introduction to Windows Operating System: All Directory 

Manipulation: Creating Directory, Sub Directory, Renaming, Coping 

and Deleting the Directory File Manipulation: Creating a File, 

Deleting, Coping, renaming a File Using accessories such as 

calculator, paint brush, CD player, etc 

 

       51-52 

                                                 UNIT III  

 MS-Word: History, Creating, Saving, Opening, Importing, 

Exporting and Inserting document, Formatting pages, Alignment, 

Paragraphs and Sections. Indents and Out dents, creating lists and 

numberings Formatting Commands: Headings, Styles, Fonts and 

Size  

 

53-72 

 Editing, Viewing Text, Finding and Replacing text, Headers and 

Footers, Inserting page breaks, Page numbers, Special Symbols and 

Dates Mail merge, Preview and Printings command. 
 

73-84 

 MS-PowerPoint: History, Creating, Saving, Opening, existing 

presentation, Creating and Saving a Presentation using Auto Content 

Wizard, Design Template, Blank Presentation the Slide Sorter View, 

Slide Show, Inserting pictures and graphics and Printing Slides. 

 

    85-102 

                                               UNIT IV  

 MS-Excel: Introduction, Components of Excel History, Creating, 

Saving, Opening, Spreadsheet, Formatting numbers and Text, Graph 

and Chart Formatting Commands, Menu Bar, Toolbars, Statistical 

Functions using Formulas. And Calculation of various Financial.  
 

103-130 
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UNIT-1 

        What is Data? 

Data is the complete list of facts and details like text, observations, figures, symbols and description of 

things. It is the raw list of facts that are processed to gain information. The basic concept of data is 

associated with scientific research collected by different research organisations. 

      What is Information? 

Information is the processed, organised and structured data. It provides context for data. However, both the 

terms are used together; information can be easily understood than data. 
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                                        Data Information 

Data is unorganised raw facts that need 

processing without which it is seemingly random 

and useless to humans 

Information is a processed, organised data presented 

in a given context and is useful to humans. 

Data is an individual unit that contains raw 

material which does not carry any specific 

meaning. 

Information is a group of data that collectively carry 

a logical meaning. 

Data doesn’t depend on information. Information depends on data. 

It is measured in bits and bytes. 

Information is measured in meaningful units like 

time, quantity, etc. 

Data is never suited to the specific needs of a 

designer. 

Information is specific to the expectations and 

requirements because all the irrelevant facts and 

figures are removed, during the transformation 

process. 

An example of data is a student’s test score 

The average score of a class is the information 

derived from the given data. 

 

Data Information An example of data is a student's test score 

The average score of a class is the information derived from the given data.  
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     The main characteristics of computer are the following below. 

       Speed  

Accuracy 

Diligence 

Reliability 

Versatility 

Storage Capacity 

Automatic 

Quick Decision 

Multitasking 

No Feeling 

Power of Remembering 
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 No IQ   

1. Speed 

Computers are much faster to perform mathematical calculations than human. The computer is capable 

of performing millions of tasks per second.It takes an hour or a day for a person to do a mathematical 

calculation or any work, to do the same calculation or work to a computer do in microseconds or 

nanoseconds 

     2. Accuracy 

A computer is very accurate. It does not make any kind of mistake in calculating. Sometimes we get 

some error but these are because of the mistake performed by us.The Accuracy Of the computer is 

constantly high and it can perform hundred of operation with the carry-out calculation and analysis 

accurately and speedily.  

3. Diligence 

A person gets tired of doing some work in a few hours and a computer has the ability to do any work 

continuously for many hours, days, months. Even after the computer has worked for such a long time, 

there is no decrease in its ability to work and the accuracy of the result. The computer does work 

without any discrimination. A computer is free from monetary and tiredness. 

          4. Reliability 

Reliability is a very big characteristic of computer. Today almost all the big industries or big e-

Commerce companies like Amazon and Flipkart, and big search engine companies like - Google and Bing, 

all these companies are dependent on computers. Today every major industry and companies in the world 

have full confidence in their computers, and their entire business is running from computers. 

Today the work of all companies is being done through computers. These companies store all their data 

in the computer, the data of these companies are many types of data such as the amount to be paid, the 

date of payment and many other types of data, which will be used in future when the time comes for 

that data use. 

Data place to another place is transported through a computer in a very short time.  

The computer does all its work very honestly. Night or day, the computer continues its work without 

being tired. Today this is the reason why big e-commerce companies and industries blindly trust 

computers. 

 

5. Versatility 

Versatility is the Characteristics of a computer. Its means is that the computer is capable of working in 

almost every field. 
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         Today computers are being used almost everywhere like schools, colleges, hospitals, offices, 

railway stations, hotels etc. A computer system is multitasking so that you can do two tasks very easily 

at the same time. 

6. Storage Capacity 

Computer systems have a very large capacity to store any type of data. A computer can store and resell 

any information due to its storage capacity. Computers have the ability to store all types of data such as 

data, pictures, files, programs, games, and sound for many years and later we can get any data in a few 

seconds at any time for taking that information and for future retrieval. 

7. Automatic 

A computer is an automatic machine because once started on a job they carry on until the job is 

finished without any human assistance. 

8. Quick Decision 

The computer takes the decision very quickly, given by the user which is the instruction arithmetic data 

or logic data. 

     All Mathematical data is called arithmetic data. Copy Document, Delete file, open camera etc this 

type of data is called Logical data. 

9. Multitasking 

Multitasking is also a very special feature of computers. A user can do different types of tasks on the 

computer at the same time.  

Like we are using MS Word in computer as well as listening to songs and also getting printouts. We 

can do a lot of work at the same time.  

10. No Feeling 

In computers, like humans, there is no feeling and emotion, nor does the computer have any knowledge 

and experience, because a computer is a machine which works continuously on the instruction of 

humans without any selfishness and without tiredness.  

 

11. Power of Remembering 

Power of remembering is also very special Characteristics of the computer. You can store many types 

of information and data on your computer in very large quantities. Whenever you need this data in 

future, you can get that data in a few seconds matter why.You can get the data even after a long time. It 

depends on you, after how long or after how many years you need the data.  
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     12. No IQ 

A computer is a dumb machine, without a user, a computer is a useless machine and device. Until a user 

does not give any instruction, it cannot do any work and only after completing the instruction, he 

completes that work very fast.A computer system is completely dependent on us humans how to work. 

For an example, if you want to multiply two numbers, then writing such 3 & 3, the computer will not 

give us any result, unless we instruct 3 * 3 =, the computer multiplies that number and gives the result. 

So a computer cannot make its own decision 

Fields / Application of Computers 

Computers play a role in every field of life. They are used in homes, business, educational institutions, 

research organizations, medical field, government offices, entertainment, etc  

Home 

 Computers are used at homes for several purposes like online bill payment, watching movies or shows 

at home, home tutoring, social media access, playing games, internet access, etc. They provide 

communication through electronic mail. They help to avail work from home facility for corporate 

employees. Computers help the student community to avail online educational support.  

Medical Field 

 Computers are used in hospitals to maintain a database of patients’ history, diagnosis, X-rays, live 

monitoring of patients, etc. Surgeons nowadays use robotic surgical devices to perform delicate 

operations, and conduct surgeries remotely. Virtual reality technologies are also used for training 

purposes. It also helps to monitor the fetus inside the mother’s womb.  

 Entertainment 

Computers help to watch movies online, play games online; act as a virtual entertainer in playing 

games, listening to music, etc. MIDI instruments greatly help people in the entertainment industry in 

recording music with artificial instruments. Videos can be fed from computers to full screen 

televisions. Photo editors are available with fabulous features. 

Industry 

 Computers are used to perform several tasks in industries like managing inventory, designing purpose, 

creating virtual sample products, interior designing, video conferencing, etc. Online marketing has 

seen a great revolution in its ability to sell various products to inaccessible corners like interior or rural 

areas. Stock markets have seen phenomenal participation from different levels of people through the 

use of computers.  

Education 

 Computers are used in education sector through online classes, online examinations, referring e-books, 

online tutoring, etc. They help in increased use of audio-visual aids in the education field. 

Government 
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 In government sectors, computers are used in data processing, maintaining a database of citizens and 

supporting a paperless environment. The country’s defense organizations have greatly benefitted from 

computers in their use for missile development, satellites, rocket launches, etc. 

Banking 

 In the banking sector, computers are used to store details of customers and conduct transactions, such 

as withdrawal and deposit of money through ATMs. Banks have reduced manual errors and expenses 

to a great extent through extensive use of computers. 

Business 

 Nowadays, computers are totally integrated into business. The main objective of business is transaction 

processing, which involves transactions with suppliers, employees or customers. Computers can make 

these transactions easy and accurate. People can analyze investments, sales, expenses, markets and 

other aspects of business using computers.  

Training 

 Many organizations use computer-based training to train their employees, to save money and improve 

performance. Video conferencing through computers allows saving of time and travelling costs by 

being able to connect people in various locations. 

     Arts 

Computers are extensively used in dance, photography, arts and culture. The fluid movement of dance 

can be shown live via animation. Photos can be digitized using computers. 

 

 

 

 

                                   INPUT OUTPUT DEVICES 

The computer will be of no use unless it is able to communicate with the outside world. Input 

/Output devices are required for users to communicate with the computer. In simple terms, input 

devices bring information INTO the computer and output devices bring information OUT of a 

computer system. These input/output devices are also known as peripherals since they surround 

the CPU and memory of a computer system. 
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Some commonly used Input /Output devices are listed in table below. 

 

 

Input 

Devices 

Output 

Devices 

Keyboard Monitor 

Mouse LCD 

Joystick Printer 

Scanner Plotter 

Light Pen  

Touch 

Screen 

 

 

I. Input Devices 

(a) Keyboard 

It is a text base input device that allows the user to input alphabets, numbers and other 

characters. It consists of a set of keys mounted on a board 

 

         Alphanumeric keys 

It consists of keys for English alphabets, 0 to 9 numbers, and special characters like + 

 / * ( ) etc. 

Function Keys 

There are twelve function keys labeled F1, F2, F3… F12. The functions assigned to these keys 

differ from one software package to another. These keys are also user programmable keys. 

 

Special-function Keys 

These keys have special functions assigned to them and can be used only for those specific 

purposes. Functions of some of the important keys are defined below. 
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Enter 

It is similar to the ‘return’ key of the typewriter and is used to execute a command or program. 

Spacebar 

It is used to enter a space at the current cursor location. 

Backspace 

This key is used to move the cursor one position to the left and also delete the character in that 

position. 

Delete 

It is used to delete the character at the cursor position. 

Insert 

Insert key is used to toggle between insert and overwrite mode during data entry. 

Shift 

This key is used to type capital letters when pressed along with an alphabet key. Also used to 

type the special characters located on the upper-side of a key that has two characters defined on 

the same key. 

Caps Lock 

Cap Lock is used to toggle between the capital lock features. When ‘on’, it locks the 

alphanumeric keypad for capital letters input only. 

         

        Control keys  

Control key is used in conjunction with other keys to provide additional functionality on the 

keyboard. 

Alt 

Also like the control key, Alt key is always used in combination with other keys to perform 

specific tasks. 

Esc 

This key is usually used to negate a command. Also used to cancel or abort executing programs. 

Numeric Keypad 

Numeric keypad is located on the right side of the keyboard and consists of keys having 

numbers (0 to 9) and mathematical operators (+  * /) defined on them. This keypad is 

provided to support quick entry for numeric data. 

Cursor Movement Keys 

These are arrow keys and are used to move the cursor in the direction indicated by the arrow (up, 

down, left, right). 
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(b)       Mouse 

The mouse is a small device used to point to a particular place on the screen and select in order 

to perform one or more actions. It can be used to select menu commands, size windows, start 

programs etc. 

The most conventional kind of mouse has two buttons on top: the left one being used most 

frequently. 

Mouse Actions 

Left Click : Used to select an item. 

Double Click : Used to start a program or open a file. 

Right Click : Usually used to display a set of commands. 

Drag and Drop : It allows you to select and move an item from one location to another. To 

achieve this place the cursor over an item on the screen, click the left mouse button and while 

holding the button down move the cursor to where you want to place the item, and then release 

it. 

 

 

 

 

C) Joystick 

The joystick is a vertical stick which moves the graphic cursor in a direction the stick is moved. 

It typically has a button on top that is used to select the option pointed by the cursor. Joystick is 

used as an input device primarily used with video games, training simulators and controlling 

robots 

 

 

D) Scanner 

Scanner is an input device used for direct data entry from the source document into the computer 

system. It converts the document image into digital form so that it can be fed into the computer. 
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Capturing information like this reduces the possibility of errors typically experienced during large data 

entry. 

 

 

II.Output Devices 

 
(a) Monitor 

Monitor is an output device that resembles the television screen and uses a Cathode Ray Tube 

(CRT) to display information. The monitor is associated with a keyboard for manual input of 

characters and displays the information as it is keyed in. It also displays the program or 

application output. Like the television, monitors are also available in different sizes. 

 

 

(b) Liquid Crystal Display (LCD) 

LCD was introduced in the 1970s and is now applied to display terminals also. Its advantages 

like low energy consumption, smaller and lighter have paved its way for usage in portable 

computers (laptops). 
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 c) Printer 

Printers are used to produce paper (commonly known as hardcopy) output. Based on the 

technology used, they can be classified as Impact or Non-impact printers. 

Impact printers use the typewriting printing mechanism wherein a hammer strikes the paper 

through a ribbon in order to produce output. Dot-matrix and Character printers fall under this 

category. 

Non-impact printers do not touch the paper while printing. They use chemical, heat or electrical 

signals to etch the symbols on paper. Inkjet, Deskjet, Laser, Thermal printers fall under this 

category of printers. 

 

 

 

When we talk about printers we refer to two basic qualities associated with printers: resolution, 

and speed. Print resolution is measured in terms of number of dots per inch (dpi). Print speed is 

measured in terms of number of characters printed in a unit of time and is represented as 

characters-per-second (cps), lines-per-minute (lpm), or pages-per-minute (ppm). 

 

Printer uses ink to put data on paper or transparency. There are many types of printers. 

1)Dot Matrix Printer 

2)Ink Jet Printer 
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3)Daisy Wheel Printer 

4) Laser Printer 

Speed of the printer is measured in cps(character per second),lpm(line per minute),ppm(pages per minute). 

The quality of the print is  measured in dpi(dots per inch). Some printers can print in color also. Dot matrix, 

ink jet and laser printers are most commonly used printers. Printer can be classified into two categories 

according to the technologies used in them. Impact printer and non-impact printer. An impact printer uses a 

device to press/strike something against the ribbon to put a character on the page. Dot matrix, daisy and line 

printer are impact printers. 

 Non-impact printers print without having a mechanism to strike against a sheet of paper. Ink jet, laser and 

thermal printer are non-impact printer. 

 

Dot Matrix Printer:  It uses dots to form a characters on a paper. Dots are made by pins.  Dot matrix printer 

is made up of steel pins which strike the paper through a inked ribbon to create a pattern of tiny dots. The 

quality of print depends upon the number of steel pins in the machine. 

 

Daisy Wheel printer:   In this type of printer, the part that puts the characters looks like a wheel. Numbers 

and letters are arranged in a wheel.  And the  daisy wheel spins until the correct letter is in position. Then 

hammer strikes the  character against the ribbon, printing it on the paper. 

 

Line Printer: It prints a complete line of text at a time. It uses drum or chain with all the characters in the 

character set on it. The drum or chain moves and prints the necessary characters in the right place. 

 

Ink jet printer:  It prints the character using fine jet of ink which comes out from the tiny nozzles onto the 

paper. The ink is kept in reservoir and fed into the firing chambers just below each nozzle. 

 

Laser Printer: It uses a beam of light (laser beam) to convert binary data into print. The laser puts an electric 

charge in the shape of a character on the rotating drum. The dry ink or toner stick only to the drum where it 

has been charged. These printers are very fast. They can print a whole page at once. 

 

Thermal Printer: It uses heat to put the characters on the paper. The paper has a spacial coating on it. The 

printer uses heated wires to turn the paper black. It is basically used for taking ECG in hospital or lab. 
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d) Plotter 

 

Plotters are used to print graphical output on paper. It interprets computer commands and makes line 

drawings on paper using multicolored automated pens. It is capable of producing graphs, drawings, 

charts, maps etc. 

Computer Aided Engineering (CAE) applications like CAD (Computer Aided Design) and CAM 

(Computer Aided Manufacturing) are typical usage areas for plotters.  

 

                                          

 

 

 

Advantages of computer 

Multitasking  

 Multitasking is one of the major advantage of computer. Person can perform multiple task, multiple 

operation, calculate numerical problems within few seconds. Computer can perform trillion of 

instructions per second.  

Speed  

 Now computer is not just a calculating device. Now a day’s computer has very important role in 

human life. One of the main advantages of computer is its incredible speed, which helps human to 

complete their task in few seconds. All the operations can be performed very fast just because of its 

speed else wise it takes a long time to perform the task.  

Cost/ Stores huge amount of data  

 It is a low cost solution. Person can save huge data within a low budget. Centralized database of 

storing information is the major advantage that can reduce cost.  
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Accuracy  

 One of the root advantage of computer is that can perform not only calculations but also with accuracy. 

Data Security  

 Protecting digital data is known as data security. Computer provide security from destructive forces 

and from unwanted action from unauthorized users like cyber attack or access attack. 

Disadvantages of computer 

The use of computer has also created some problems in society which are as follows. 

Unemployment 

 Different tasks are performed automatically by using computers. It reduces the need of people and 

increases unemployment in society.  

Wastage of time and energy 

 Many people use computers without positive purpose. They play games and chat for a long period of 

time. It causes wastage of time and energy. Young generation is now spending more time on the social 

media websites like Facebook, Twitter etc or texting their friends all night through smartphones which 

is bad for both studies and their health. And it also has adverse effects on the social life.  

Data Security 

 The data stored on a computer can be accessed by unauthorized persons through networks. It has 

created serious problems for the data security. 

Computer Crimes 

 People use the computer for negative activities. They hack the credit card numbers of the people and 

misuse them or they can steal important data from big organizations. 

Privacy violation 

 The computers are used to store personal data of the people. The privacy of a person can be violated if 

the personal and confidential records are not protected properly. 

Health risks 

 The improper and prolonged use of computer can results in injuries or disorders of hands, wrists, 

elbows, eyes, necks and back. The users can avoid health risks by using the computer in proper 

position. They must also take regular breaks while using the computer for longer period of time. It is 

recommended to take a couple of minutes break after 30 minutes of computer usage.  

Virus and hacking attacks  
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 Virus is a worm and hacking is simply an unauthorized access over computer for some illicit purpose. 

Virus is being transferred from email attachment, viewing an infected website advertisement, through 

removable device like USB etc. once virus is transferred in host computer it can infect file, overwrite 

the file etc. 

For example: Huge portion of internet was going down including Twitter, Netflix, Reddit and CNN in 

October 2016 because the largest DDoS attack was launched on service provider DYN using IoT 

Botnet.  

 

 

 

Hardware 

 
Hardware refers to the physical elements of a computer. This is also sometime called the machinery or the 

equipment of the computer. Examples of hardware in a computer are the keyboard, the monitor, the mouse and 

the central processing unit. However, most of a computer's hardware cannot be seen; in other words, it is not 

an external element of the computer, but rather an internal one, surrounded by the computer's casing (tower). 

A computer's hardware is comprised of many different parts, but perhaps the most important of these is 

the motherboard. The motherboard is made up of even more parts that power and control the computer. 

In contrast to software, hardware is a physical entity. Hardware and software are interconnected, without 

software, the hardware of a computer would have no function. However, without the creation of hardware to 

perform tasks directed by software via the central processing unit, software would be useless. 

 

Hardware Components 

Computer hardware is a collection of several components working together. Some parts are essential and 

others are added advantages. Computer hardware is made up of CPU and peripherals as shown in image 

below. 
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RAM, which stands for random access memory, and ROM, which stands for read-only memory, are both 

present in your computer. RAM is volatile memory that temporarily stores the files you are working 

on. ROM is non-volatile memory that permanently stores instructions for your computer. Find out more 

about RAM. 

 

Software 

 
Software, commonly known as programs or apps, consists of all the instructions that tell the hardware how to 

perform a task. These instructions come from a software developer in the form that will be accepted by 

the platform (operating system + CPU) that they are based on. For example, a program that is designed for the 

Windows operating system will only work for that specific operating system.  

A set of instructions that drives computer to do stipulated tasks is called a program. Software instructions are 

programmed in a computer language, translated into machine language, and executed by computer. 

 

Software is capable of performing many tasks, as opposed to hardware which can only perform mechanical 

tasks that they are designed for. Software provides the means for accomplishing many different tasks with the 

same basic hardware 
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Differences between Software and Hardware are sorted out below − 

Sr.No

. 

Software Hardware 

1 It is a collection of programs to 

bring computer hardware system 

into operation. 

It includes physical components of computer 

system. 

2 It includes numbers, alphabets, 

alphanumeric symbols, identifiers, 

keywords, etc. 

It consists of electronic components like ICs, 

diodes, registers, crystals, boards, insulators, 

etc. 

3 Software products evolve by adding 

new features to existing programs to 

support hardware. 

Hardware design is based on architectural 

decisions to make it work over a range of 

environmental conditions and time. 

4 It will vary as per computer and its 

built-in functions and programming 

language. 

It is mostly constructed for all types of 

computer systems. 

5 It is designed and developed by 

experienced programmers in high-

level language. 

The hardware can understand only low-level 

language or machine language. 

6 

It is represented in any high-level 

language such as BASIC, COBOL, 

C, C++, JAVA, etc. 

The hardware works only on binary codes 1’s 

and 

0’s.  

7 The software is categorized as 

operating system, utilities, language 

processor, application software, etc. 

The hardware consists of input devices, 

output devices, memory, etc. 
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Functional Components of a Computer / Block Diagram 

Computer: A computer is a combination of hardware and software resources which integrate together and 

provides various functionalities to the user. Hardware are the physical components of a computer like the 

processor, memory devices, monitor, keyboard etc. while software is the set of programs or instructions that 

are required by the hardware resources to function properly. 

There are a few basic components that aids the working-cycle of a computer i.e. the Input- Process- Output 

Cycle and these are called as the functional components of a computer. It needs certain input, processes that 

input and produces the desired output. The input unit takes the input, the central processing unit does the 

processing of data and the output unit produces the output. The memory unit holds the data and instructions 

during the processing. 

Digital Computer: A digital computer can be defined as a programmable machine which reads the binary 

data passed as instructions, processes this binary data, and displays a calculated digital output. Therefore, 

Digital computers are those that work on the digital data. 

Details of Functional Components of a Digital Computer 

 

 Input Unit :The input unit consists of input devices that are attached to the computer. These devices take 

input and convert it into binary language that the computer understands. Some of the common input 

devices are keyboard, mouse, joystick, scanner etc. 

 Central Processing Unit (CPU0 : Once the information is entered into the computer by the input device, 

the processor processes it. The CPU is called the brain of the computer because it is the control center of 

the computer. It first fetches instructions from memory and then interprets them so as to know what is to 

be done. If required, data is fetched from memory or input device. Thereafter CPU executes or performs 

the required computation and then either stores the output or displays on the output device. The CPU has 

three main components which are responsible for different functions – Arithmetic Logic Unit (ALU), 

Control Unit (CU) and Memory registers 

 Arithmetic and Logic Unit (ALU) : The ALU, as its name suggests performs mathematical calculations 

and takes logical decisions. Arithmetic calculations include addition, subtraction, multiplication and 

division. Logical decisions involve comparison of two data items to see which one is larger or smaller or 

equal. 
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 Control Unit : The Control unit coordinates and controls the data flow in and out of CPU and also 

controls all the operations of ALU, memory registers and also input/output units. It is also responsible for 

carrying out all the instructions stored in the program. It decodes the fetched instruction, interprets it and 

sends control signals to input/output devices until the required operation is done properly by ALU and 

memory. 

 

 Memory Registers : A register is a temporary unit of memory in the CPU. These are used to store the 

data which is directly used by the processor. Registers can be of different sizes(16 bit, 32 bit, 64 bit and 

so on) and each register inside the CPU has a specific function like storing data, storing an instruction, 

storing address of a location in memory etc. The user registers can be used by an assembly language 

programmer for storing operands, intermediate results etc. Accumulator (ACC) is the main register in the 

ALU and contains one of the operands of an operation to be performed in the ALU. 

 

 Memory : Memory attached to the CPU is used for storage of data and instructions and is called internal 

memory The internal memory is divided into many storage locations, each of which can store data or 

instructions. Each memory location is of the same size and has an address. With the help of the address, 

the computer can read any memory location easily without having to search the entire memory. when a 

program is executed, it’s data is copied to the internal memory ans is stored in the memory till the end of 

the execution. The internal memory is also called the Primary memory or Main memory. This memory is 

also called as RAM, i.e. Random Access Memory. The time of access of data is independent of its 

location in memory, therefore this memory is also called Random Access memory (RAM). Read this 

for different types of RAMs 

 

 Output Unit : The output unit consists of output devices that are attached with the computer. It converts 

the binary data coming from CPU to human understandable form. The common output devices are 

monitor, printer, plotter etc. 

 

 

 

Interconnection between Functional Components 
 

A computer consists of input unit that takes input, a CPU that processes the input and an output unit that 

produces output. All these devices communicate with each other through a common bus. A bus is a 

transmission path, made of a set of conducting wires over which data or information in the form of electric 

signals, is passed from one component to another in a computer. The bus can be of three types – Address bus, 

Data bus and Control Bus. 

Following figure shows the connection of various functional components: 
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The address bus carries the address location of the data or instruction. The data bus carries data from one 

component to another and the control bus carries the control signals. The system bus is the common 

communication path that carries signals to/from CPU, main memory and input/output devices. The 

input/output devices communicate with the system bus through the controller circuit which helps in managing 

various input/output devices attached to the computer. 

 

 

SMPS 

A switched-mode power supply (SMPS) is an electronic circuit that converts power using switching devices 

that are turned on and off at high frequencies, and storage components such as inductors or capacitors to 

supply power when the switching device is in its non-conduction state. 

Switching power supplies have high efficiency and are widely used in a variety of electronic equipment, 

including computers and other sensitive equipment requiring stable and efficient power supply. 

A switched-mode power supply is also known as a switch-mode power supply or switching-mode power 

supply. 

 

 

Advantages of switched-mode power supplies: 
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 Higher efficiency of 68% to 90% 

 Regulated and reliable outputs regardless of variations in input supply voltage 

 Small size and lighter 

 Flexible technology 

 High power density 

Disadvantages: 

 Generates electromagnetic interference 

 Complex circuit design 

 Expensive compared to linear supplies 

 

 

Classification of Computer 

 

Computer scan is broadly classified by their speed and computing power. 

Sr.No. Type Specifications 

1 PC (Personal 

Computer) or 

Micro-

Computers 

It is a single user computer system having a moderately powerful 

microprocessor. It is termed as a computer that is equipped 

microprocessor as its CPU. 

2 Workstation It is also a single user computer system, similar to the personal 

computer, however, has a more powerful microprocessor. 

3 Mini-Computer It is a multi-user computer system, capable of supporting hundreds of 

users simultaneously. 

4 Main Frame It is a multi-user computer system, capable of supporting hundreds of 

users simultaneously. Software technology is different from 

minicomputer. 

5 Super-

Computer 

It is an extremely fast computer, which can execute hundreds of 

millions of instructions per second. 

 

 

 

PC (Personal Computer) 
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A PC can be defined as a small, relatively inexpensive computer 

designed for an individual user. PCs are based on the microprocessor technology that enables manufacturers to 

put an entire CPU on one chip. Businesses use personal computers for word processing, accounting, desktop 

publishing, and for running spreadsheet and database management applications. At home, the most popular 

use for personal computers is playing games and surfing the Internet. 

Although personal computers are designed as single-user systems, these systems are normally linked together 

to form a network. In terms of power, nowadays high-end models of the Macintosh and PC offer the same 

computing power and graphics capability as low-end workstations by Sun Microsystems, Hewlett-Packard, 

and Dell. 

Workstation 

 

The workstation is a computer used for engineering applications (CAD/CAM), desktop publishing, software 

development, and other such types of applications which require a moderate amount of computing power and 

relatively high-quality graphics capabilities. 

Workstations generally come with a large, high-resolution graphics screen, a large amount of RAM, inbuilt 

network support, and a graphical user interface. Most workstations also have mass storage device such as a 

disk drive, but a special type of workstation, called diskless workstations, comes without a disk drive. 

Common operating systems for workstations are UNIX and Windows NT. Like PC, workstations are also 

single-user computers like PC but are typically linked together to form a local area network, although they can 

also be used as stand-alone systems. 
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Minicomputer 

It is a midsize multi-processing system capable of supporting up to 250 users simultaneously. 

 

Mainframe 

The mainframe is very large in size and is an expensive computer capable of supporting hundreds or even 

thousands of users simultaneously. Mainframe executes many programs concurrently and supports much 

simultaneous execution of programs. 

 

Supercomputer 

Supercomputers are one of the fastest computers currently available. Supercomputers are very expensive and 

are employed for specialized applications that require an immense amount of mathematical calculations 

(number-crunching). 
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For example, weather forecasting, scientific simulations, (animated)graphics, fluid dynamic calculations, 

nuclear energy research, electronic design, and analysis of geological data (e.g. in petrochemical prospecting) 

 

Number System 

The technique to represent and work with numbers is called number system. Decimal number system is the 

most common number system. Other popular number systems include binary number system, octal number 

system, hexadecimal number system, etc. 

When we type some letters or words, the computer translates them in numbers as computers can understand 

only numbers. A computer can understand the positional number system where there are only a few symbols 

called digits and these symbols represent different values depending on the position they occupy in the 

number. 

The value of each digit in a number can be determined using − 

 The digit 

 The position of the digit in the number 

 The base of the number system (where the base is defined as the total number of digits available in the number 

system) 

Decimal Number System 

The number system that we use in our day-to-day life is the decimal number system. Decimal number system 

has base 10 as it uses 10 digits from 0 to 9. In decimal number system, the successive positions to the left of 

the decimal point represent units, tens, hundreds, thousands, and so on. 

Each position represents a specific power of the base (10). For example, the decimal number 1234 consists of 

the digit 4 in the units position, 3 in the tens position, 2 in the hundreds position, and 1 in the thousands 

position. Its value can be written as 

(1 x 1000)+ (2 x 100)+ (3 x 10)+ (4 x l) 

(1 x 103)+ (2 x 102)+ (3 x 101)+ (4 x l00) 

1000 + 200 + 30 + 4 

1234 

As a computer programmer or an IT professional, you should understand the following number systems 

which are frequently used in computers. 
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S.No. Number System and Description 

1 Binary Number System 

Base 2. Digits used : 0, 1 

2 
Octal Number System 

Base 8. Digits used : 0 to 7 

3 
Hexa Decimal Number System 

Base 16. Digits used: 0 to 9, Letters used : A- F 

Binary Number System 

The easiest way to vary instructions through electric signals is two-state system – on and off. On is 

represented as 1 and off as 0, though 0 is not actually no signal but signal at a lower voltage. The number 

system having just these two digits – 0 and 1 – is called binary number system. 

Each binary digit is also called a bit. Binary number system is also positional value system, where each digit 

has a value expressed in powers of 2, as displayed here. 

 

In any binary number, the rightmost digit is called least significant bit (LSB) and leftmost digit is 

called most significant bit (MSB). 

 

And decimal equivalent of this number is sum of product of each digit with its positional value. 

110102 = 1×24 + 1×23 + 0×22 + 1×21 + 0×20 

= 16 + 8 + 0 + 2 + 0 

= 2610 

Example 

Binary Number: 101012 



 
 
 
BBA-3rd semester (IT Tools for Business)                      www.sbs.ac.in 

                                                                                                            

Calculating Decimal Equivalent − 

Step Binary Number Decimal Number 

Step 1 101012 ((1 x 24) + (0 x 23) + (1 x 22) + (0 x 21) + (1 x 20))10 

Step 2 101012 (16 + 0 + 4 + 0 + 1)10 

Step 3 101012 2110 

Note − 101012 is normally written as 10101. 

Octal Number System 

Characteristics of the octal number system are as follows − 

 Uses eight digits, 0,1,2,3,4,5,6,7 

 Also called as base 8 number system 

 Each position in an octal number represents a 0 power of the base (8). Example 80 

 Last position in an octal number represents a x power of the base (8). Example 8x where x represents the last position 

– 1 

 

Octal number system has eight digits – 0, 1, 2, 3, 4, 5, 6 and 7. Octal number system is also a positional 

value system with where each digit has its value expressed in powers of 8, as shown here − 

 

Decimal equivalent of any octal number is sum of product of each digit with its positional value. 

7268 = 7×82 + 2×81 + 6×80 

= 448 + 16 + 6 

= 47010 

 

Example 

Octal Number: 125708 

Calculating Decimal Equivalent − 
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Step Octal Number Decimal Number 

Step 1 125708 ((1 x 84) + (2 x 83) + (5 x 82) + (7 x 81) + (0 x 80))10 

Step 2 125708 (4096 + 1024 + 320 + 56 + 0)10 

Step 3 125708 549610 

Note − 125708 is normally written as 12570. 

 

Hexadecimal Number System 

Octal number system has 16 symbols – 0 to 9 and A to F where A is equal to 10, B is equal to 11 and so on 

till F. Hexadecimal number system is also a positional value system with where each digit has its value 

expressed in powers of 16, as shown here − 

 

Decimal equivalent of any hexadecimal number is sum of product of each digit with its positional value. 

27FB16 = 2×163 + 7×162 + 15×161 + 10×160 

= 8192 + 1792 + 240 +10 

= 1023410 

Example 

Hexadecimal Number: 19FDE16 

Calculating Decimal Equivalent − 

Step Binary 

Number 

Decimal Number 

Step 1 19FDE16 ((1 x 164) + (9 x 163) + (F x 162) + (D x 161) + (E x 160))10 

Step 2 19FDE16 ((1 x 164) + (9 x 163) + (15 x 162) + (13 x 161) + (14 x 160))10 
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Step 3 19FDE16 (65536+ 36864 + 3840 + 208 + 14)10 

Step 4 19FDE16 10646210 

Note − 19FDE16 is normally written as 19FDE. 

 

 

 

 

 

Conversions 

There are many methods or techniques which can be used to convert numbers from one base to another. We'll 

demonstrate here the following − 

 Decimal to Other Base System 

 Other Base System to Decimal 

 Other Base System to Non-Decimal 

 Shortcut method − Binary to Octal 

 Shortcut method − Octal to Binary 

 Shortcut method − Binary to Hexadecimal 

 Shortcut method − Hexadecimal to Binary 

Decimal to Other Base System 

Steps 

 Step 1 − Divide the decimal number to be converted by the value of the new base. 

 Step 2 − Get the remainder from Step 1 as the rightmost digit (least significant digit) of new base 

number. 

 Step 3 − Divide the quotient of the previous divide by the new base. 

 Step 4 − Record the remainder from Step 3 as the next digit (to the left) of the new base number. 

Repeat Steps 3 and 4, getting remainders from right to left, until the quotient becomes zero in Step 3. 

The last remainder thus obtained will be the Most Significant Digit (MSD) of the new base number. 

Example − 

Decimal Number: 2910 
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Calculating Binary Equivalent − 

Step Operation Result Remainder 

Step 1 29 / 2 14 1 

Step 2 14 / 2 7 0 

Step 3 7 / 2 3 1 

Step 4 3 / 2 1 1 

Step 5 1 / 2 0 1 

As mentioned in Steps 2 and 4, the remainders have to be arranged in the reverse order so that the first 

remainder becomes the Least Significant Digit (LSD) and the last remainder becomes the Most Significant 

Digit (MSD). 

Decimal Number − 2910 = Binary Number − 111012. 

Other Base System to Decimal System 

Steps 

 Step 1 − Determine the column (positional) value of each digit (this depends on the position of the 

digit and the base of the number system). 

 Step 2 − Multiply the obtained column values (in Step 1) by the digits in the corresponding columns. 

 Step 3 − Sum the products calculated in Step 2. The total is the equivalent value in decimal. 

Example 

Binary Number − 111012 

Calculating Decimal Equivalent − 

Step Binary Number Decimal Number 

Step 1 111012 ((1 × 24) + (1 × 23) + (1 × 22) + (0 × 21) + (1 × 20))10 

Step 2 111012 (16 + 8 + 4 + 0 + 1)10 
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Step 3 111012 2910 

Binary Number − 111012 = Decimal Number − 2910 

Other Base System to Non-Decimal System 

Steps 

 Step 1 − Convert the original number to a decimal number (base 10). 

 Step 2 − Convert the decimal number so obtained to the new base number. 

Example 

Octal Number − 258 

Calculating Binary Equivalent − 

Step 1 − Convert to Decimal 

Step Octal Number Decimal Number 

Step 1 258 ((2 × 81) + (5 × 80))10 

Step 2 258 (16 + 5 )10 

Step 3 258 2110 

Octal Number − 258 = Decimal Number − 2110 

Step 2 − Convert Decimal to Binary 

Step Operation Result Remainder 

Step 1 21 / 2 10 1 

Step 2 10 / 2 5 0 

Step 3 5 / 2 2 1 
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Step 4 2 / 2 1 0 

Step 5 1 / 2 0 1 

Decimal Number − 2110 = Binary Number − 101012 

Octal Number − 258 = Binary Number − 101012 

Shortcut method - Binary to Octal 

Steps 

 Step 1 − Divide the binary digits into groups of three (starting from the right). 

 Step 2 − Convert each group of three binary digits to one octal digit. 

Example 

Binary Number − 101012 

Calculating Octal Equivalent − 

Step Binary Number Octal Number 

Step 1 101012 010 101 

Step 2 101012 28 58 

Step 3 101012 258 

Binary Number − 101012 = Octal Number − 258 

Shortcut method - Octal to Binary 

Steps 

 Step 1 − Convert each octal digit to a 3 digit binary number (the octal digits may be treated as decimal 

for this conversion). 

 Step 2 − Combine all the resulting binary groups (of 3 digits each) into a single binary number. 

Example 

Octal Number − 258 
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Calculating Binary Equivalent − 

Step Octal Number Binary Number 

Step 1 258 210 510 

Step 2 258 0102 1012 

Step 3 258 0101012 

Octal Number − 258 = Binary Number − 101012 

Shortcut method - Binary to Hexadecimal 

Steps 

 Step 1 − Divide the binary digits into groups of four (starting from the right). 

 Step 2 − Convert each group of four binary digits to one hexadecimal symbol. 

Example 

Binary Number − 101012 

Calculating hexadecimal Equivalent − 

Step Binary Number Hexadecimal Number 

Step 1 101012 0001 0101 

Step 2 101012 110 510 

Step 3 101012 1516 

Binary Number − 101012 = Hexadecimal Number − 1516 

Shortcut method - Hexadecimal to Binary 

Steps 

 Step 1 − Convert each hexadecimal digit to a 4 digit binary number (the hexadecimal digits may be 

treated as decimal for this conversion). 
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 Step 2 − Combine all the resulting binary groups (of 4 digits each) into a single binary number. 

Example 

Hexadecimal Number − 1516 

Calculating Binary Equivalent − 

Step Hexadecimal Number Binary Number 

Step 1 1516 110 510 

Step 2 1516 00012 01012 

Step 3 1516 000101012 

Hexadecimal Number − 1516 = Binary Number − 101012 

 

 

 

 

 

 

 

 

 

 

 

                                                                                 UNIT II 

Types of Software  

There are two main classifications of software, which are namely,  
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1. System Software  

2. Application Software.  

1. System Software In case of a system software, it helps the user as well as the hardware to 

function and even interact with each other easily. Essentially, it is a software which is used to 

manage the behavior of the computer hardware in order to offer basic functionalities which are 

needed by the user. In simpler word, it can be said that system software is essentially an 

intermediate or even a middle layer between the user as well as the hardware.  

This software sanctions an environment or platform for the other software to easily work in. 

Hence, it is the reason why the system software is quite important in the management of the 

entire computer system. Whenever you turn on the computer first, it is this system software 

which gets initialized and then gets loaded in the system’s memory. System software 

essentially runs in the background, and it isn’t actually utilized by the end-users. Due to this 

reason, the system software is also known popularly as “low-level software”. 

(a) Operating System Being a prominent example for system software, it is essentially a 

collection of software which handles resources as well as offers general services for various 

other application which actually run over them. There are different types of operating systems 

like embedded, real-time, distributed, single-user, multi-user, mobile, internet and much more 

Some of the key examples of operating systems are as follows: 

Examples of Operating Systems are MS Windows mac OS Linux iOS Android CentOS 

Ubuntu Unix 

 

 

 

 b. Device Drivers 

This type of software controls particular hardware which is essentially attached to the system. 

Different hardware devices which require a driver to connect to a system easily consist of 

displays, printers, sound cards, hard disks, keyboard, and mice. 

Few of the examples of such drivers are: 

BIOS Driver  

Motherboard Drivers  
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Display Drivers  

ROM Drivers  

Printer Drivers  

     USB Drivers  

      Sound Card Driver  

      VGA Drivers 

c. Firmware It is actually a permanent software which is embedded in the system’s read-

only memory. It is essentially a set of instructions which are permanently stored onto to the 

hardware device. It offers vital information regarding how a particular device interacts with 

different other hardware.  

Some of the examples of firmware are: Computer Peripherals  

Embedded Systems  

     BIOS 

d. Utility These software are designed to assist in analysing, as well as optimizing, along 

with configuring and maintaining a given computer system. It provides support to the 

computer infrastructure. Software like disk cleanup and management tools, anti-viruses, 

defragmenters, compression tools etc. are all utility software. Some of its examples are: 

 Norton Antivirus 

 WinRAR WinZip 

 Ccleaner  

      Windows File Explore 

2. Application Software They are also popularly known as end-user programs or even 

productivity programs which assist the user in completing various tasks like conducting 

online research, making notes, designing graphics, maintaining accounts, carrying out 

calculations or even playing computer games. They essentially lie above the system 

software. They are actually used by the end-user as well as have specific functionality or 

tasks which they are designed to perform. These software are often developed through 

custom software development, based on the requirements of the users. There is a variety of 

application software. Some of them are: 
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 a. Word Processors Such applications are meant for documentation. It also assists in 

storing as well as formatting and even printing of the documents. Key examples of such 

software are: MS Word  

 Apple iWork-Pages  

 Corel WordPerfect  

          

 c. Multimedia Software This is software which is able to play, create as well as record 

images, audio or even video files. This software are utilized for animation, video 

editing, graphics as well as image editing. Due to the high demand for such software, 

every software product development company has vast avenues in developing them. 

Some of the examples of such software are: 

  Adobe Photoshop  

   Picasa  

VLC Media Player 

 d. Web Browsers These software are utilized to browse the internet. Web browsers 

assist the users in locating as well as retrieving data well across the web. Some of the 

key examples of them are:  

 Google Chrome 

  Mozilla Firefox 

 

 1. Freeware These software are available free of cost. A user can easily download them 

from the internet and can easily use them without paying any charges or fees 

 Examples of freeware softwares  

 Adobe Reader 

 Skype 

2. Shareware This software is distributed freely to users on a fixed trial basis. It generally 

comes with a set time limit, and on the expiration of the time limit, the user is finally asked to 

pay a fixed fee for the continued services. 

 Adobe Acrobat 

    PHP Debugger  

 3. Open-source Such types of software are usually available to users along with their 

source code which means that the user can easily modify and distribute the software as 

well as add additional features to them. They can either be chargeable or free. Few of 

the examples of such software are:  

 Mozilla Firefox 
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Computer Languages 

Introduction:   

A language is the main medium of communicating between the Computer systems and the most common are 

the programming languages. As we know a Computer only understands binary numbers that is 0 and 1 to 

perform various operations but the languages are developed for different types of work on a Computer. A 

language consists of all the instructions to make a request to the system for processing a task. From the first 

generation and now fourth generation of the Computers there were several programming languages used to 

communicate with the Computer. Here we will go in the detail of the Computer language and its types. 

 

Computer Language Description: 

A Computer language includes various languages that are used to communicate with a Computer machine. 

Some of the languages like programming language which is a set of codes or instructions used for 

communicating the machine. Machine code is also considered as a computer language that can be used for 

programming. And also HTML which is a computer language or a markup language but not a programming 

language. Similarly there are different types of languages developed for different types of work to be 

performed by communicating with the machine. But all the languages that are now available are categorized 

into two basic types of languages including Low-level language and High level language. 
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Low Level Language: 

Low level languages are the machine codes in which the instructions are given in machine language in the 

form of 0 and 1 to a Computer system. It is mainly designed to operate and handle all the hardware and 

instructions set architecture of a Computer. The main function of the Low level language is to operate, manage 

and manipulate the hardware and system components. There are various programs and applications written in 

low level languages that are directly executable without any interpretation or translation. The most famous and 

the base of all programming languages “C” and “C++” are mostly used Low level languages till today. Low 

level language is also divided into two parts are Machine language and Assembly language. 

 Machine Language is one of the low-level programming languages which is the first generation 

language developed for communicating with a Computer. It is written in machine code which represents 

0 and 1 binary digits inside the Computer string which makes it easy to understand and perform the 

operations. As we know a Computer system can recognize electric signals so here 0 stands for turning 

off electric pulse and 1 stands for turning on electric pulse. It is very easy to understand by the 

Computer and also increases the processing speed. 

The main advantage of using Machine language is that there is no need of a translator or interpreter to translate 

the code, as the Computer directly can understand. But there are some disadvantages also like you have to 

remember the operation codes, memory address every time you write a program and also hard to find errors in 

a written program. It is a machine dependent and can be used by a single type of Computer. 

 Assembly Language is the second generation programming language that has almost similar structure 

and set of commands as Machine language. Instead of using numbers like in Machine languages here 

we use words or names in English forms and also symbols. The programs that have been written using 

words, names and symbols in assembly language are converted to machine language using an 

Assembler. Because a Computer only understands machine code languages that’s why we need an 

https://www.informationq.com/Computer-Language-and-its-Types
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Assembler that can convert the Assembly level language to Machine language so the Computer gets the 

instruction and responds quickly. 

 

The main disadvantage of this language is that it is written only for a single type of CPU and does not run on 

any other CPU. But its speed makes it the most used low level language till today which is used by many 

programmers. 

High Level Language: 

The high level languages are the most used and also more considered programming languages that helps a 

programmer to read, write and maintain. It is also the third generation language that is used and also running 

till now by many programmers. They are less independent to a particular type of Computer and also require a 

translator that can convert the high level language to machine language. The translator may be an interpreter 

and Compiler that helps to convert into binary code for a Computer to understand. There is various high level 

programming languages like C, FORTRAN or Pascal that are less independent and also enables the 

programmer to write a program. 

 

Computer Memory  

Memory is an internal storage area in a computer, which is availed to store data and programs either 

permanently or temporarily.  Computer memory is broadly divided into two groups and they are: 

 Primary memory and 

 Secondary memory 

 

The diagrammatic representation of the classification of computer memory is shown below: 

  

Classification of the Computer Memory 

 

When the main memory holds instructions and data when a program is executing, the auxiliary memory or 

secondary memory holds data and programs which are not currently in use and furnishes long term storage. 

The primary memory and secondary memory are further classified into distinct groups and those are explained 

in the below diagram: 
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                          Classification of Primary Memory and Secondary Memory 

Primary memory: 
Primary memory is the only type of memory which is directly accessed by the CPU. The CPU continuously 

reads instructions stored in the primary memory and executes them. Any data that has to be operated by the 

CPU is also stored. The information is transferred to various locations through the BUS. Primary memories 

are of two types. They are: 

 RAM 

 ROM 

 

1. RAM: It stands for Random Access Memory. Here data can be stored temporarily, so this type of 

memory is called as temporary memory or volatile memory because when power fails the data from 

RAM will be erased. The information stored in the RAM is basically loaded from the computer’s disk 

and includes information related to the operating system and applications that are currently executed 

by the processor. RAM is considered random access because any memory cell can be directly accessed 

if its address is known. RAM is of distinct types like SRAM, DRAM, and VRAM. 

 

2. ROM: It stands for Read Only Memory. In this, the data will be furnished by the manufacturers 

regarding the system, so this information can simply be read by the user but cannot add new data or it 

cannot be modified. ROMs are of distinct types: 

 PROM – Programmable Read Only Memory 

 EPROM – Erasable Programmable Read Only Memory 

 EEPROM – Electrically Erasable Programmable Read Only Memory 

 

 

 

Secondary memory: 
Secondary memory or auxiliary memory consists of slower and less expensive device that communicates 

indirectly with CPU via main memory. The secondary memory stores the data and keeps it even when the 

power fails. It is used to store or save large data or programs or other information. The secondary storage 

devices are explained below: 

 Magnetic disks 

 Magnetic tape 

 Optical disk 

 USB flash drive 

 Mass storage devices 
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1.Magnetic disks: Magnetic disks are made of rigid metals or synthetic plastic material. The disk platter is 

coated on both the surfaces with magnetic material and both the surfaces can be used for storage. The 

magnetic disk furnishes direct access and is for both small and large computer systems. The magnetic disk 

comes in two forms: 

 Floppy disks 

 Hard disks 

 

2. Magnetic tape: magnetic tape is serial access storage medium and it can store a large volume of data at low 

costs. The conventional magnetic tape is in reels of up to 3600 feet made of Mylar plastic tape. The tape is 

one-half inch in width and is coated with magnetic material on one side. The reel of tape is loaded on a 

magnetic tape drive unit. During any read/write operation, the tape is moved from one spool to another in the 

same way as in the audiocassette tape recorder. The magnetic tape is densely packed with magnetic spots in 

frames across its width. 

 

3. Optical drives: optical drives are a storage medium from which data is read and to which it is written by 

lasers. Optical disks can store much more data up to 6GB. Optical store devices are the most widely used and 

reliable storage devices. The most widely used type of optical storage devices are explained below: 

 CD – ROM 

 DVD – ROM 

 CD – RECORDABLE 

 CD – REWRITABLE 

 PHOTO – CD 

 

4. USB flash drives: USB flash drives are removable, rewritable and are physically much smaller drives, 

which have the weight of less than 30g. In the year of 2010, the storage capacity of the USB flash drives was 

as large as 256GB. Such devices are a good substitute for floppy disks and CD – ROMs as they are smaller, 

faster, have thousands of times more capacity, and are more durable and reliable. Until 2005, most desktop 

and laptop computers had floppy disk drives, but nowadays floppy disk drives have been abandoned in favour 

of USB ports. The USB connector is often protected inside a removable cap, although it is not likely to be 

damaged if unprotected. USB flash drives draw power from the computer through external USB connection. 

The most widely used USB flash drives are the memory cards. 

 

 

5. Mass storage devices: Mass storage devices refer to the saving of huge data in a persistent manner. Mass 

storage machines can store up to several trillion bytes of data and hence are used to store or save large 

databases, such as the information of customers of a big retail chain and library transactions of students in a 

college. Some of the commonly used mass storage devices are explained below: 

 Disk array 

 Automated tape 

 CD – ROM jukebox 

 

 

 Introduction to Windows 
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What is a Window? 

A computer window is an enclosed frame that is used to display programs, text files, images etc. It comprises 

a title bar at the top, minimize, restore down, maximize and close buttons. Other features will be present 

depending on the program you are using. You can have a number of windows open at the same time. The use 

of these buttons is as follows:- 
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For Example 

Features of Windows XP Desktop 

The above table explains the various features of the Windows XP desktop.  

Feature Explanation 

1. Taskbar 
It is located on the bottom edge of the desktop though it can be dragged to other locations. It 

shows the applications that are currently running on a computer 

2. The Start 

button 
It is located at the bottom left hand corner. It is used to launch or start programs 

3. System tray Located at the bottom right hand corner. It shows time and the status of system components 

4. Icons Graphical representation of objects like pictures, programs, files, devices, etc 

5. RecycleBin Where everything you delete in a computer goes to 

6. Short cut 

icons 
 Provides a quick access to program they are linked to 

What's new in Windows XP – Best Features 

Windows XP Operating system was introduced as an update to Windows 2000. Besides, it replaced Windows 

95/98. Microsoft unveiled Windows XP with new features and benefits over its precursor. Some of the main 

features of Windows XP are listed below: 
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Remote Desktop Windows XP professional OS enables user to use remote desktop connection feature means 

they can sit at a PC and access another PC remotely. 

Device Driver Rollback: This new Windows XP feature let users uninstall installed device driver. If users 

install device driver that causes system instability then they can easily roll back the previous driver. 

Built-in CD burner When Windows XP arrived, it came up with its own in-built CD burner feature. Now 

there is no longer need to install CD burning software, user can burn files directly via Windows Explorer.  

Encrypted file system support muti-user: This feature is for Windows XP Professional, Encrypted file 

system make it possible to access encrypted files and folders by multiple users.  

Device support improvement: Windows XP supports USB 2.0, Intel High Definition Audio based hardware, 

FireWire, & Windows Image Acquisition based scanners etc.  

Desktop Tools and Development Environment     

Creating, Renaming, Copying, and Removing Directories and Files 

Creating New Files 

To create a new file in the current directory, 

1. Select New from the context menu or File menu and then select the type of file to create.  

1. An icon for that file type, for example, an M-file icon , with the default name Untitledn, appears at the 
end of the list of files shown in the Current Directory browser. 

2. Type over Untitledn with the name you want to give to the new file.  
3. Press Enter or Return.  

4.The file is added. 

Creating New Directories / Folder 

To create a new directory in the current directory, 

1. Click the New Folder button in the Current Directory browser toolbar, or select New -> Folder from the 
context menu.  

1. An icon, with the default name New Folder appears at the end of the list of files shown in the Current 
Directory browser. 

Renaming Files and Directories 

To rename a file or directory, select the item, right-click, and select Rename from the context menu. Type 

over the existing name with the new name for the file or directory, and press Enter or Return. The file or 

directory is renamed. 

http://matlab.izmiran.ru/help/techdoc/matlab_env/ws_pat29.html
http://matlab.izmiran.ru/help/techdoc/matlab_env/ws_pat31.html
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Cutting or Deleting Files and Directories 

To cut or delete files and directories, 

1. Select the files and directories to remove. Use Shift+click or Ctrl+click to select multiple items.  
2. Right-click and select Cut or Delete from the context menu.  

1. The files and directories are removed. 

Files and directories you delete from the Current Directory browser go to the Recycle Bin on Windows (or the 

Trash Can on Macintosh platforms). If you do not want the selected items to go to the Recycle Bin, press 

Shift+Delete. A confirmation dialog box displays before the items are deleted if you have set that option in 

your operating system. For example, on Windows, right-click the Recycle Bin, select Properties from the 

context menu, and then, under the Global tab, select the check box to Display delete confirmation dialog. 

Copying and Pasting Files and Directories 

Use the Current Directory browser, to copy (or cut) and paste files and directories: 

1. Select the files or directories to copy. Use Shift+click or Ctrl+click to select multiple items. For a directory, the 
entire contents are copied, including all subdirectories and files.  

2. Right-click and select Copy from the context menu.  
3. Navigate to the file or directory where you want to paste the items you just copied.  
4. Right-click and select Paste from the context menu.  

 

 

 

 

 

Windows provides several accessories, or applications, that you can use to help you in your work. These 

accessories are not full-featured programs, but they are useful for specific jobs in the Windows environment. 

Accessories include a calculator, a painting program, a word processor, a text editor, and Internet applications. 

(Internet &  "Connecting to the Internet." 

Windows can perform these Tasks: 

1. Using Calculator 

2. Using Command Prompt 

3. Using WordPad 

4. Typing Text 

5. Selecting Text 

6. Deleting Text 

7. Copying Text 

8. Moving Text 
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9. Formatting Text 

10. Using Notepad 

11. Using Paint 

12. Drawing a Shape with Paint 

13. Adding Text to a Drawing 

14. Adding Color to a Drawing 

15. Erasing Part of a Drawing 

Reference/Source:   

1. www.studymafia.org 

2.www.tutorialspoint.com 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                  UNIT –III 

 

WORD PROCESSING 
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Word processing describes the process of creating or editing a document using a word processor, such as Microsoft 

Word, Google Docs, or OpenOffice Writer. For example, with a word processor, a student could create a book report 

and then print it, save it to a disk, display it on the screen, or send it over e-mail. Also, a person looking for a job could 

create a résumé using a word processor, then e-mail or print and mail it to job recruiters. 

 

 

 

 

 

 

 

Menu bar 

https://www.computerhope.com/jargon/o/openoffi.htm
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Menu bar This is the traditional windows style drop-down menu.  When you point to any menu title and click once 

with the mouse, the menu will open displaying all the commands available under this menu. Clicking on the desired 

command would tell Word to execute that command. Some commands have ellipses (…) in front of them. These 

commands have further sub commands. Commands appearing in dim mode cannot be executed unless the 

prerequisite functions required by that command have been performed, e.g. you cannot use the Copy or Cut command 

from the Edit menu unless you have selected a piece of text first. Many commands also have a keyboard shortcuts 

specified against their names. 

 

Standard toolbar 

 

Standard toolbar Toolbars contain buttons, drop-down menus and other controls that help you to quickly alter the 

appearance and arrangement of documents by executing a variety of word commands. Toolbars are very helpful and 

convenient in quicklyexecuting commands without having to go through menus. The standard toolbar contains icons 

for basic functions like opening files, saving files, printing files, cut, copy, pasteetc. 

 

Formatting toolbar 

This contains icons for changing the look of your text (called “formatting” in computer jargon); for example, there are 

icons for changing fonts, styles, font sizes, text alignment etc. 

Ruler  

The Ruler lets you make changes to margins and indents, and helps you create document as per dimensions required. 

Scroll tools 

 These helps you travel within your document. You can go anywhere, up and down, right and left in your document 

mainly by two ways: Using the horizontal and vertical scroll bars with the help of the mouse; Or using the keyboard to 

press PgUp,  PgDn, Home, End and arrow keys. 

 

 

 

 

 

 

 

Status bar 
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Also called the Status Area, this is the normally the last line on your screen. This gives the following information about 

your work— 

 

 Current Page 

 Section Number 

 Current/Total pages in the document 

 Current Cursor Position (where the cursor is presently located) 

 Current Line Number 

 Current Column Number 

 Record Macro-whether macro recording is On or not 

 Track Revision-whether revisions have been made or not 

 Extend Selection 

 Over type mode-whether you are in Insert mode or overwrite mode 

 

Cursor 

 Also called the Insertion Pointer, this denotes the place where text, graphics or any other item would be placed when 

you type, overwrite or insert them. This looks like a tall, skinny toothpick and keeps blinking so that you can locate it 

easily. 

 

Mouse pointer 

 When your mouse pointer looks like an I-beam you should be able to move it freely on the screen. This is used for 

either placing the cursor at the desired place (take the mouse pointer there and click) or choosing any command either 

from the menu or from toolbars. The mouse pointer changes shape when in the process of doing certain tasks and the 

cursor disappears. 

 

 

 

 

TOOLBARS AND THEIR ICONS 
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Word Standard Toolbar 
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o 

File management 

 

Creating a New Document 

 

o Click on File Menu 

o Select and click New option 

o Otherwise click  button on the standard toolbar 

 

 Opening an Existing Document: 

 

o Click File Menu 

o Select and click Open option 

o Otherwise click button on the Standard toolbar. 

o Double click on the file from the open window 

 

 Saving a Document 

o Click File Menu 

o Select and click Save button. 

o Otherwise click button on the Standard toolbar. 

 

 Moving through the document 

 

o Open any word document. You can move the cursor to any location on the screen by using the arrow 

keys on the keyboard. 

o  Right arrow key is used to move one position to the right of the cursor 

o  Left arrow key is used to move one position to the left of the cursor. 
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o  Up arrow key is used to move one position to the top of the cursor. 

o  Down arrow key is used to move one position to the down   of the cursor. 

o Page Up key is used to move down the screen at a time 

o Page down key issued to move up the screen at a time 

o  Hold down Ctrl key and press Home to move to beginning of the document. 

o  Hold down Ctrl key and press End to move to end of the document. 

 

 

Editing Word document 

 Cut , Copy and Paste options 

 

 These options will allow you to Cut or Copy a piece of text from one location and to paste at 

a new location. 

 

 To do these functions, 

 

o Place the cursor at the beginning of the text to be selected. Drag the mouse pointer over the text. 

The text will now appear in reverse video as shown below: 

 

 Jawahar Knowledge Center 

o Click Edit menu and then click on Cut option (or) click icon on the Standard Toolbar. Move 

the cursor to the place where you want the text to be pasted. 

 

o Click Edit menu and then click Paste option(or)click icon on the Standard Toolbar. 

 

 For copying the text from one location to other location the same procedure is to be followed. The 

difference between Cut and Copy is that while using the Cut option the text will be removed from its original 
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location and pasted at a new location, where as when using Copy option a copy of the selected text is pasted 

at new location without disturbing the original tex
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Searching text 

 

 Open any document. 

 Click Edit menu and then click Find option. You will get a screen as shownbelow. 

 

 

 In Find What text box type the word you want to find and then click Find Next button. 

 Continue clicking Find Next button until you get the screen shown below. 

 

 

 Click OK button and then click X to close Find and Replace 

Dialog box. 

 

Replacing text 

 Open any word document. 

 Click Edit menu and then click Replace option. You will get the dialog box as shown below 

and type the word with which you want to replace. 
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 Click ReplaceAll button once. You get the below dialogbox. 

 

 

 

 Click OK button and then click X toc lose Find and Replace 

Dialog box. 

 

 

Moving the cursor to a specific page 

 

 If your word document contains more than one page, you can directly go to specified page 

by clicking Edit menu and then clicking Go To option. You will get the dialog box as shown 

below. 
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 In the Enter page number text box, type the required page number as shown below. 

 

 

 Click Go To button. Cursor will immediately jump to page4. 

 Click Close button to close Find and Replace dialog box. 

 

Formatting documents 

 

Bold, Underline and Italicize the selected text 

 Open a word document. 

 Block the text by first clicking at the start of the text and holding the left mouse button and 

drag to the desired position and then release the left mouse button. The selected area will 

be highlighted. 

 Move the mouse pointer to the button on the Standard Toolbar and click once. 

 Move the mouse pointer outside your text and click to release the highlighting. Your text 

will now appear in BOLDFACE. 

 Like this you can underline or italicize the desired text by using the following buttons 
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Left aligning, centering , right aligning and justifying text 

 

Left Centre Right Justify 

 

 Open a word document. 

 Block the text by first clicking at the start of the text and holding the left mouse button and 

drag to the desired position and then release the left mouse button. The selected area will 

be highlighted. 

 Move the mouse pointer to Align Left button on the toolbar and click once. Your selected 

text will be left aligned. 

 Move the mouse pointer to Align right button on the toolbar and click once. Your selected 

text will be right aligned. 

 Move the mouse pointer to Center button on the toolbar and click once. Your selected text 

will be centered. 

 Move the mouse pointer to Justify button on the toolbar and click once. Your selected text 

will be justified. 

 

Creating Bulleted and Numbered list 

 

o If a list of items are to be numbered automatically it can be done using Numbered List option 

 

 Ex: Microsoft Office consists of MS-Word 

 MS-Excel 

 MS-PowerPoint MS-Access 

 MS-Outlook 

 

o The above text is to be selected with mouse. 
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o Click on  the Numbered List button on the toolbar  

o Move out of the text and click to release the highlighting. 

o Your text will now look like this 

 

 MS-Word 

 MS-Excel 

 MS-PowerPoint 

 MS-Access 

 MS-Outlook 

 

o Now re-select the text 

o Click the Bulleted List button on the toolbar. 
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b 

 

 The numbers should be replaced with bullets as shown below 

 

 MS-Word 

 MS-Excel 

 MS-PowerPoint 

 MS-Access 

 MS-Outlook 

 

Indenting Paragraphs 

 

 Select a paragraph with the mouse. 

 Click on  the  Right(increase)Indent button on the toolbar. 

 

 Leave the highlighting on and click once more on the Right Indent button. 

 Click  once  on  the Left Indent button. Your text should now be indented by one Tab stop. 

Each time you click, the paragraph is moved one tab stop. 

 

Changing case of text 

 

 You can change the selected text into either UPPERCASE, lowercase, Title case or toggle case 

 

 Highlight the text. Select the Format menu option 

 Choose Change Case option. You will get the dialog box shown below. 
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 From the list of options select UPPERCASE to convert lower case into uppercase 
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                            Indenting text with tabs 

 

 Type your name and address as you would at the head of a letter, but aligned with the left 

margining. 

 

K.Manohar H.No10-334/3, 

V.P. Nagar, Malakpet, Hyderabad. 

 

 Move the cursor to the start of each line and press the Tab key. Just as with the right indent 

button, your text will move right. How much it moves will depend on the tab settings, which 

you can change in the Format, Tabs menu as shown below. 

 

 

 

Font Controlling 

 

 To get different character styles we can change Font type 
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 Click on Format menu 

 Select Font option. You will get the following screen. 
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 You can set Font type, Font Style and Font size and Color 

of the selected text. 

 Click OK button. 

 

Note: The above options are also available on the Formatting Toolbar 

 

Font style Font Type Font size Color 
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MAIL MERGE 

Mail merge is a feature within most data processing applications that enables users to send a similar 

letter or document to multiple recipients. It enables connecting a single form template with a data 

source that contains information about the recipient’s name, address and other predefined and 

supported data 

Mail merge primarily enables automating the process of sending bulk mail to customers, subscribers 

or general individuals. Mail merge works when a data file is stored that includes the information of 

the recipients to whom the letter is to be sent. This file can be a spreadsheet or database file 

containing separate fields for each different type of information to be merged within the letter. 

The second file is the word document or the letter template. The recipients' information on the letter 

template is kept empty. When the mail merge process is initiated, the recipients' data from 

spreadsheet or database is fetched and placed within the empty field in the letter, one by one, until 

all letters are created. 

 

Steps To Perform Mail Merging 

1. In a blank Microsoft Word document, click on the Mailings tab, and in the Start Mail 

Merge group, click Start Mail Merge. 
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1. Click Step-by-Step Mail Merge Wizard. 

 

 

 

2. Select your document type. In this demo we will select Letters. Click Next: Starting document. 
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3. Select the starting document. In this demo we will use the current (blank) document. 

Select Use the current document and then click Next: Select recipients. 

 

 
 

Note that selecting Start from existing document (which we are not doing in this demo) changes the 

view and gives you the option to choose your document. After you choose it, the Mail Merge Wizard 

reverts to Use the current document. 

 

 

 

 

 

4. Select recipients. In this demo we will create a new list, so select Type a new list and then 

click Create. 
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o Create a list by adding data in the New Address List dialog box and clicking OK. 
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o Save the list. 

 

 

o Note that now that a list has been created, the Mail Merge Wizard reverts to Use an 

existing list and you have the option to edit the recipient list. 
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o Selecting Edit recipient list opens up the Mail Merge Recipients dialog box, where you 

can edit the list and select or unselect records. Click OK to accept the list as is. 

 

 

 

 

 

 

 

 

 

 

 

 

o Click Next: Write your letter. 
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5. Write the letter and add custom fields. 

 

o Click Address block to add the recipients' addresses at the top of the document. 
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o In the Insert Address Block dialog box, check or uncheck boxes and select options on 

the left until the address appears the way you want it to. 

 

 

o Note that you can use Match Fields to correct any problems. Clicking Match 

Fields opens up the Match Fields dialog box, in which you can associate the fields from 

your list with the fields required by the wizard. 

 
 

6. Press Enter on your keyboard and click Greeting line... to enter a greeting. 
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7. In the Insert Greeting Line dialog box, choose the greeting line format by clicking the drop-

down arrows and selecting the options of your choice, and then click OK. 
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8. Note that the address block and greeting line are surrounded by chevrons (« »). Write a short 

letter and click Next: Preview your letters 

. 

 

 

Preview your letter and click Next: Complete the merge. 
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  Click Print to print your letters or Edit individual letters to further personalize some or all of the 

letters. 
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Microsoft PowerPoint 

Microsoft PowerPoint is powerful presentation software developed by Microsoft. It is a 

standard component of the company's Microsoft Office suite software, and is bundled together 

with Word, Excel and other Office productivity tools. The program uses slides to convey 

information rich in multimedia. The term "slide" refers to the slide projector, which this 

software effectively replaces. 

 

 

Features of MS PowerPoint 

PowerPoint is a complete presentation Graphics package. It gives everything that we need to 

produce a professional-looking presentation. PowerPoint offers word processing software, 

outlining, drawing, graphing, and presentation management tools- all designed to be easy to 

use and learn. 

 

 

 

 

 

Below are the various Features avalaible for MS Powerpoint 

1) Adding Smart Art 
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Don’t confuse Smart Art with the similarly named WordArt. Where WordArt just allows you to 
display text using a wide variety of different formats and effects, SmartArt is a comprehensive 
and flexible business diagram tool that greatly improves upon the ‘Diagram Gallery’ feature 
found in previous versions of Office. 

Click the insert SmartChart Graphic to choose from a selection of options. 

2) Inserting Shapes 

 

 

If you need to include some sort of diagram in your presentation, then the quickest and easiest 
way is probably to use Smart Art. However, it is important to be able to include shapes 
independently of Smart Art and worth being familiar with the various Drawing Tool format 
options. 

Not only will they be useful if you do need to manually draw a diagram (and SmartArt doesn’t 
suit all diagrams), but they can also be applied to objects on a slide that you might not 
immediately think of as shapes. For example the box that contains your slide title or your 
content. This can be anything from text to a video, or even the individual shapes in a SmartArt 
diagram. 

As you can see, the gallery of available shapes is very extensive. Once you have selected your 
chosen shape, you can just click in your slide to insert a default version of the shape or, to set a 
particular size and position, click and drag with the mouse to create the shape and size you 
want. 
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3) Inserting an Image 

 

 

Here are two content type icons which appear in new content Placeholders for inserting 
pictures. You can Insert Picture from File or Insert Clip Art. Alternatively, the Illustrations group 
of the Insert ribbon tab includes the same two tools. In addition, PowerPoint 2010 has a new 
‘Screenshot’ option that allows you to capture an entire window or part of a window for 
inclusion on a slide. You can also copy any image and just paste it directly to a slide. 

Insert Picture from File allows you to browse to an image file saved somewhere on your system 
whereas Clip Art is held in an indexed gallery of different media types. Clip Art is not limited to 
pictures: ‘The Results should be:’ box lets you choose between: ‘All media file types’ and one or 
more of the following different types: 

 

 Illustrations 
 Photographs 
 Video 
 Audio 

Once you have found the image you want to use, click on it to insert it into the current slide. 
You can now re-size and move the image accordingly with further editting options available 
when you right click the desired image. 
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4) Slide Transitions 

 

Properly used, slide transitions can be make your presentations clearer and more interesting 
and, where appropriate, more fun. Badly used, the effect of slide transitions can be closer to 
irritating or even nauseating. Simple animation effects are often used to add interest to bullet 
point text. Much more extreme animation effects are available but, in most cases, should be 
used sparingly if at all. 

Two main kinds of animation are available in a PowerPoint presentation: the transition from 
one slide to the next and the animation of images/text on a specific slide. 

In PowerPoint 2010 & 2013 there is also a separate Transitions ribbon tab that includes a 
gallery of different transition effects. These can be applied to selected slides or all slides. If you 
want to apply different transition effects to different groups of slides, then you might want to 
choose ‘Slide Sorter’ view from the Presentation Views group of the View ribbon. 
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5) Adding Animations 

 

 

Whereas the transition effects are limited to a single event per slide, animations can be applied 
to every object on a slide – including titles and other text boxes. Many objects can even have 
animation applied to different components, for example each shape in a Smart Art graphic, 
each paragraph in a text box and each column in a chart. Animations can be applied to three 
separate ‘events’ for each object: 

Entrance – how the object arrives on the slide 

Emphasis – an effect to focus attention on an object while it is visible 

Exit – how the object disappears from the slide 

To apply an animation effect, choose the object or objects to be animated, then choose 
Animation Styles or Add Animation from the Animations toolbar. 

Where an animation is applied to an object with different components (for instance a SmartArt 
graphic made up of several boxes), the Effect Options tool becomes available to control how 
each component will be animated. So for example, your animation can be used to introduce 
elements of an organisation chart to your slide one by one. 
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Templates 

A PowerPoint design template is a pre-made design you can use to lend cohesiveness, 
visual organization and appeal to your presentation. All you have to do is add your own 
content; the rest is already designed into the template. Even though individual slides can have 
different layouts and graphics, templates help the whole presentation go together as an 
attractive package. 

PowerPoint: Formatting a Slide 

 

To Select Text in a Text Box: 

1) Position your cursor inside the text box by clickingonce 
2) Click and drag your mouse to select the desiredtext 

To Select a Word: 

Double click your mouse on the word 
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To Select an Entire Text Box: 

Click once on the text box 

 

 

 

To Bold Text on a Slide: 

1) Select the text 
2) Click the Bold Icon on the Formatting Toolbar 

 

To Italicize Text on a Slide: 

1) Select thetext 
2) Click the Italic Icon on the Formatting Toolbar 

 

To Underline Text on a Slide 

1) Select the text 
2) Click the Underline Icon on the Formatting Toolbar 

 

To Select a Different Font 

1) Select the text 
2) Click the drop down arrow for Font on the Formatting Toolbar and select a 

font 
 

To Select a Different Font Size 

1) Select the text 
2) Click the Font Size Icon on the Formatting Toolbar and pick a different font 

size (The larger the number the larger the lettering) 
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To Change the Font Color 

1) Select the text 
2) Click the Font Color drop down arrow on the Formatting Toolbar and 

select a different font color 

 

Selecting a Slide Design 

Microsoft PowerPoint provides design templates that you can apply to a 
presentation to give it a fully designed, professional look. 

 

To Select a Design for your Presentation: 
1) Click the Design Button on your Formatting Toolbar 
2) From the Task Pane on the right, click on the desired design 

 

Note: The design, by default, is applied to all pages of the presentation. 

 

Use charts and graphs in your presentation 

You can make a chart in PowerPoint or Excel. If you have lots of data to chart, create your 

chart in Excel, and then copy it into your presentation. This is also the best way if your data 

changes regularly and you want your chart to always reflect the latest numbers. In that 

case, when you copy and paste the chart, keep it linked to the original Excel file. 

To create a simple chart from scratch in PowerPoint, click Insert > Chart and pick the chart you 

want. 

1. Click Insert > Chart. 
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2. Click the chart type and then double-click the chart you want. 

 

 

3. In the worksheet that appears, replace the placeholder data with your own information. 

 

4. When you’ve finished, close the worksheet. 

 

 



BBA-3rd semester (IT Tools for Business)                      www.sbs.ac.in 

 
 

 

The Different Types of Animations in PowerPoint 
Animations are visual effects which make your texts, images, shapes, or charts come ‘alive.’ 
They catch your audience’s attention and helps them engage with you and your presentation. 

Moreover, there are generally two types of animations you can use to make your presentation 
come alive. These are: 

 
 Transitions 

The first type of animation is called transition animation; these are animations added in 
between slides. When you transition from slide 1 to slide 2, you can add an animation in 
between the slides. You can view the different transition options by going to the Transitions 
pane on the PowerPoint ribbon. 

 

The default view shows 10 transitions, but if you click on the little arrow like you see in the 

screenshot above, then you’ll see many more options like you see here: 



BBA-3rd semester (IT Tools for Business)                      www.sbs.ac.in 

 
 

 

 

 

Transition animations have additional effect options. You will notice this when you click on the 

transition you want to use. The Effect Options button won’t be grayed out, and you can select 

additional settings. 

For example, I selected ‘Reveal’ as my transition animation. Available effect options would be: 
 Smoothly from right 

 Smoothly from left 

 Through black from right 

 Through black from left 

Here’s a screenshot of what it looks like: 
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You can also adjust the timing and duration of each transition as well as set how you want the 

slides to advance so that the transition can take place. 

 

Feel free to play around with the transition animations and effect options that work best with 
your presentation. 
 Animations 

The second type of animations brings the objects or elements within your slide to life. If you 
want to animate text, an image, shape, graph or chart, this is the type of animation you select. 
You first to have to click on the object you want to animate, then click on the Animations tab. 
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The default view shows 8 animations, but if you click on the little arrow like you see on the 

screenshot above, then you’ll see many more options like you see here: 
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You can choose from the following types of animations: 
 Entrance animations. The icons for this type of animation are colored green. If you use 

this type of animation for an object, that object will enter the slide according to your 

timing preferences. 

 Exit animations. The icons for this type of animation are colored red. The object you’ve 

added this animation to will exit the slide. 

 Emphasis animations. The icons for this kind of animation are colored yellow. The object 

won’t enter or exit the slide (unless you’ve added that particular animation to the same 

object) but will emphasize and draw attention to that object. 

 Motion path animations. This type of animation will allow you to move an object from 

one spot to another. You can specify or draw the path you want the object to take. 

In the next sections, we’ll go over how to add the 4 different types of animations to your slides. 

  
How To Add Animations to PowerPoint In 2 Simple Steps 

To add entrance animations to any object in PowerPoint, here’s what you need to do: 
1. Click on the object you want to animate. In this example, we will use a blue smiley face. 
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       2. Select the animation you want to use. For this example, we used the entrance 
animation – fade animation. We set the duration to 2.75 seconds. You will notice in the 
screenshot below that the fade animation has no effect options (the button is greyed out). 

 

 

Here’s what those numbers in the screenshot mean: 

1 – We chose the Fade animation. 

2 – There are no Effect Options for Fade Animation (the button is grayed out and not clickable) 

3 – You can adjust settings via the Advanced Animation, Timing, and Animation Pane sections 

4 – The number (1) refers to the fact that we’ve added 1 animation to our object (this is the 
Fade animation). 

5 – You can click on the Preview button to preview the animation. 

As you can see, adding animations to an object is no rocket science. You can even add entrance, 
exit, emphasis and motion path animations to a single object! 
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Important Points to Remember When Adding Animations 

It’s so easy adding animations to presentation slides that you can easily lose control. Therefore, 
you’ll find yourself animating all objects on your slides and adding slide transitions as well. 
Nevertheless, it might look fun to you, but in reality, it can distract your audience’s attention 
from the message you’re trying to convey in your presentation. 

So here are some guidelines you should following when adding animations to PowerPoint: 

 
1. Simplicity is key. Simple animations like fade and appear may not be as impressive as 

other animations available, but these add a touch of elegance to well-timed slides. It 
makes your slides look clean and simple. 

2. Limit the number of animations on a slide. One or two animations per slide should suffice. 
There’s really no need to animate every single object on each slide. 

3. Time your presentation well. Make sure your objects appear right after you introduce it. 
This keeps your audience’s interest piqued. 

4. Don’t forget to practice. Practicing your timings and your animations are key to a 
successful presentation. 

 

POWERPOINT SLIDESHOW 

A PowerPoint slideshow (PPT) is a presentation created on software from Microsoft that allows 
users to add audio, visual and audio/visual features to a presentation. It is considered to be a 
multimedia technology and also acts as a tool for collaboration and content sharing. 
PowerPoint is included in Microsoft Office, making it one of the most well-known and widely 
used brands of presentation software. 

A PowerPoint slideshow is also known as a PowerPoint presentation 

 

Slide Show view is the view that you use when showing the presentation to others. One slide 

appears onscreen at a time, completely filling the screen. You may have used this view already 

— to check your work — while you were creating the presentation. 

You can start Slide Show view from the first slide or from the current slide. The following table 

summarizes the methods of doing each. 
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Methods of Entering Slide Show 
View 

From First Slide From Current Slide 

Shortcut key(s) Press F5 Press Shift+F5 

View tab Slide Show→From 
Beginning 

Slide Show→From Current 
Slide 

View buttons (bottom right of 
screen) 

N/A Slide Show View button 

Then, after you’re in Slide Show view, you can show your presentation. Here’s how: 

 Move to the next slide (in any of these ways): 

o Click the mouse. 

o Press any key on the keyboard (except Backspace or the left arrow). 

o Right-click to display a shortcut menu and then choose Next. 

 Move to the previous slide (in any of these ways): 

o Press Backspace or the left arrow on the keyboard. 

o Right-click to display a shortcut menu and choose Previous. 

 Jump to a specific slide: 

o a.Right-click to display a shortcut menu. 

o b.Point to Go to Slide. 

o c.Click the slide you want to display. 
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 End the show (in any of these ways): 

o Click through to the end of the slide show (black screen) and then click one more time. 

o Press the Esc key. 

o Right-click to display a shortcut menu and then choose End Show. 
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                                                 Unit IV 

SPREADSHEET 

A spreadsheet or worksheet is a file made of rows and columns that help sort data, arrange data 

easily, and calculate numerical data. What makes a spreadsheet software program unique is its 

ability to calculate values using mathematical formulas and the data in cells.  

Spreadsheet overview 

Below is a basic example of what a Microsoft Excel spreadsheet looks like, as well as all the 

important features of a spreadsheet highlighted. 
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In the above example, this spreadsheet is listing three different checks, the date, their description, 

and the value of each check. These values are then added together to get the total of $162.00 in 

cell D6. That value is subtracted from the check balance to give an available $361.00 in cell D8. 

Examples and uses of a spreadsheet 

Although spreadsheets are most often used with anything containing numbers, the uses of a 

spreadsheet are almost endless. Below are some other popular uses of spreadsheets. 

 

Finance 

Spreadsheets are ideal for financial data, such as your checking account information, budgets, 

taxes, transactions, billing, invoices, receipts, forecasts, and any payment system. 

Forms 

Form templates can be created to handle inventory, evaluations, performance reviews, quizzes, 

time sheets, patient information, and surveys. 

School and grades 

Teachers can use spreadsheets to track students, calculate grades, and identify relevant data, such 

as high and low scores, missing tests, and students who are struggling. 

Lists 

Managing a list in a spreadsheet is a great example of data that does not contain numbers, but 

still can be used in a spreadsheet. Great examples of spreadsheet lists include telephone, to-do, 

and grocery lists. 

Sports 

Spreadsheets can keep track of your favorite player stats or stats on the whole team. With the 

collected data, you can also find averages, high scores, and statistical data. Spreadsheets can 

even be used to create tournament brackets. 

WORKBOOK 
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In Microsoft Excel a workbook is a collection of one or more spreadsheets, also called 

worksheets, in a single file. Below is an example of a spreadsheet called "Sheet1" in an Excel 

workbook file called "Book1." Our example also has the "Sheet2" and "Sheet3" sheet tabs that 

are also part of the same workbook. 

 

 

How to create a new workbook 

To create a new workbook in Microsoft Excel, follow the 

steps below for your version of Excel. 

Microsoft Excel 2013 and later 

1. Open Excel. 

2. Click the File 

3. Click New 

4. Under Featured, click Blank workbook. 

Microsoft Excel 2010 

1. Open Excel. 

2. Click the File tab at the top of the window. 

3. Click New 

4. Click Blank workbook. 

Microsoft Excel 2007 

1. Open Excel. 

2. Click the Office Button 

3. Select Blank and recent. 

4. In the right pane double-click Blank workbook. 

 

https://www.computerhope.com/jargon/o/officebu.htm
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The Most Common Formatting Commands 

There are many types of formatting that can be applied to Microsoft Excel worksheets. The most 

commonly used formatting commands show up on the Home tab in three groups: 

1. The Font Group. The font group commands change the appearance of text within a cell 

or of the cell itself. 

2. The Alignment Group. The alignment group commands change the position of text 

within a cell or cells. 

3. The Number Group. The number group commands change the format of numbers and 

dates within a cell. 

Formatting changes can be applied to a whole worksheet, a range of cells within a worksheet, 

individual cells, and sometimes even text within a cell. 

Selecting Ranges of Cells 

To select a range of cells in Microsoft Excel: 

1. Click on a cell in one of the corners of the range of cells you wish to select 
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2.Hold the left mouse button down and drag horizontally and vertically until the range you wish 

to select is highlighted: 

 

 

 

1. Release the click. 

You can select all the cells in a row by clicking on the number to the left of the row: 
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You can select all the cells in a column by clicking on the letter at the top of the column: 
 

 

 

Adding Colour to Worksheet Tabs 

You can customize your workbook by applying colors to the sheet tabs. This can help 

differentiate the tabs and make them stand out. 

To add color to worksheet tabs: 

1. Right-click the tab to which you want to add color. 
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2. Select Tab Color 

3. Select a color from the displayed options 
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Adding Themes to Workbooks 

You can further customize workbooks and worksheets by using a Microsoft Office theme. 

Themes apply a set of fonts, colors, and other effects. 

To apply a theme to a worksheet: 

1. On the Page Layout tab, in the Themes group, select Themes. 

 

 

2. From the drop-down menu, select a theme to apply to the worksheet 
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Bold, Italicize and Underline Text 

To bold text in Microsoft Excel: 

1. Select the cell or cells in which you wish to bold the text. 

2. On the Home tab, in the Font group, click the Bold command. 

 

To italicize text in Microsoft Excel: 

1. Select the cell or cells in which you wish to italicize the text. 

2. On the Home tab, in the Font group, click the Italic command. 

 

To underline text in Microsoft Excel: 

1. Select the cell or cells in which you wish to underline the text. 

2. On the Home tab, in the Font group, click the Underline command. 
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Set Font and Font Size 

To change the font of text or numbers in cells in Microsoft Excel: 

1. Select the cell or cells in which you wish to change the font. 

2. On the Home tab, in the Font group, click the arrow to the right of the Font command. 

 

      3. Select a font from the drop down menu: 
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To change the size of the font of text or numbers in cells in Microsoft Excel: 

1. Select the cell or cells in which you wish to change the font size. 

2. On the Home tab, in the Font group, click the arrow to the right of the Font 

Size command. Select a font size from the drop down menu: 

 

 

CELL REFERENCING 

A cell reference refers to a cell or a range of cells on a worksheet and can be used in a formula so 

that Microsoft Office Excel can find the values or data that you want that formula to calculate. 

In one or several formulas, you can use a cell reference to refer to: 

 Data from one or more contiguous cells on the worksheet. 

 Data contained in different areas of a worksheet. 

 Data on other worksheets in the same workbook. 

For example: 

This formula: Refers to: And Returns: 

=C2 Cell C2 The value in cell C2. 

=A1:F4 Cells A1 through F4 The values in all cells, but you 

must press Ctrl+Shift+Enter 

after you type in your formula. 

=Asset-Liability The cells named The value in the cell named 
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This formula: Refers to: And Returns: 

Asset and Liability Liability subtracted from the 

value in the cell named Asset. 

{=Week1+Week2} The cell ranges 

named Week1 and 

Week2 

The sum of the values of the 

cell ranges named Week1 and 

Week 2 as an array formula. 

=Sheet2!B2 Cell B2 on Sheet2 The value in cell B2 on Sheet2. 

 

Cell references in Excel are very important. Understand the difference between relative, absolute 

and mixed reference, and you are on your way to success. 

Relative Reference 

By default, Excel uses relative references. See the formula in cell D2 below. Cell D2 references 

(points to) cell B2 and cell C2. Both references are relative. 

 

 

1. Select cell D2, click on the lower right corner of cell D2 and drag it down to cell D5. 

 

https://www.excel-easy.com/introduction/range.html#fill-range
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Cell D3 references cell B3 and cell C3. Cell D4 references cell B4 and cell C4. Cell D5 

references cell B5 and cell C5. In other words: each cell references its two neighbors on the left. 

Absolute Reference 

See the formula in cell E3 below. 

1. To create an absolute reference to cell H3, place a $ symbol in front of the column letter and 

row number ($H$3) in the formula of cell E3. 

 

2. Now we can quickly drag this formula to the other cells. 

 

The reference to cell H3 is fixed (when we drag the formula down and across). As a result, the 

correct lengths and widths in inches are calculated. 
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Mixed Reference 

Sometimes we need a combination of relative and absolute reference (mixed reference). 

1. See the formula in cell F2 below. 

 

2. We want to copy this formula to the other cells quickly. Drag cell F2 across one cell, and look 

at the formula in cell G2. 
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Do you see what happens? The reference to the price should be a fixed reference to column B. 

Solution: place a $ symbol in front of the column letter ($B2) in the formula of cell F2. In a 

similar way, when we drag cell F2 down, the reference to the reduction should be 

a fixed reference to row 6. Solution: place a $ symbol in front of the row number (B$6) in the 

formula of cell F2. 

Result: 

 

Note: we don't place a $ symbol in front of the row number of $B2 (this way we allow the 

reference to change from $B2 (Jeans) to $B3 (Shirts) when we drag the formula down). In a 

similar way, we don't place a $ symbol in front of the column letter of B$6 (this way we allow 

the reference to change from B$6 (Jan) to C$6 (Feb) and D$6 (Mar) when we drag the formula 

across). 

3. Now we can quickly drag this formula to the other cells. 

 

The references to column B and row 6 are fixed. 
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CREATING FORMULAS IN EXCEL 

Formulas and functions are the building blocks of working with numeric data in Excel. 

What is a formula? 

It is the simplest form, a formula is an expression made up of cell addresses and arithmetic 

operators. Formulas can also be made up of discrete values i.e. =6*3. Excel evaluates the 

formula to a value. An example of a formula looks as follows. 

=A2 * D2 / 2 

HERE, 

 "=" tells Excel that this is a formula, and it should evaluate it. 

 "A2" * D2" makes reference to cell addresses A2 and D2 then multiplies the values 

found in these cell addresses. 

 "/" is the division arithmetic operator 

 "2" is a discrete value 

Formulas practical exercise 

We will work with the sample data for the home budget to calculate the subtotal. 

 Create a new workbook in Excel 

 Enter the data shown in the home supplies budget above. 

 Your worksheet should look as follows. 

 

We will now write the formula that calculates the subtotal 

Set the focus to cell E4 

Enter the following formula. 

=C4*D4 

https://www.guru99.com/images/5-2015/050215_0816_Introductio1.png
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HERE, 

 "C4*D4" uses the arithmetic operator multiplication (*) to multiply the value of the cell 

address C4 and D4. 

Press enter key 

You will get the following result 

 

The following animated image shows you how to auto select cell address and apply the same 

formula to other rows. 

 

https://www.guru99.com/images/5-2015/050215_0816_Introductio2.png
https://www.guru99.com/images/5-2015/excel_formulas_demo2.gif
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What is a function? (Function Wizard) 

A function is a predefined formula. Functions allow you to use descriptive names to 

automatically apply formulas for you. Examples of functions include; 

 SUM for summation of a range of numbers 

 AVERAGE for calculating the average of a given range of numbers 

 COUNT for counting the number of items in a given range 

The importance of functions 

Functions increase user productivity when working with excel. Let's say you would like to 

get the grand total for the above home supplies budget. To make it simpler, you can use a 

formula to get the grand total. Using a formula, you would have to reference the cells E4 through 

to E8 one by one. You would have to use the following formula. 

= E4 + E5 + E6 + E7 + E8 

With a function, you would write the above formula as 

=SUM (E4:E8) 

As you can see from the above function used to get the sum of a range of cells, it is much more 

efficient to use a function to get the sum than using the formula which will have to reference a 

lot of cells. 
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Common functions 

Let's look at some of the most commonly used functions in Excel. We will start 

with statistical functions. 

S/N FUNCTION CATEGORY DESCRIPTION USAGE 

01 SUM Math & Trig Adds all the values in a range of cells =SUM(E4:E8) 

02 MIN Statistical Finds the minimum value in a range of cells =MIN(E4:E8) 

03 MAX Statistical Finds the maximum value in a range of cells =MAX(E4:E8) 

04 AVERAGE Statistical Calculates the average value in a range of cells =AVERAGE(E4:

E8) 

05 COUNT Statistical Counts the number of cells in a range of cells =COUNT(E4:E8) 

06 LEN Text Returns the number of characters in a string text =LEN(B7) 

07 SUMIF Math & Trig Adds all the values in a range of cells that meet a 

specified criteria. 

=SUMIF(range,criteria,[sum_range]) 

=SUMIF(D4:D8,"

>=1000",C4:C8) 

08 AVERAGEIF Statistical Calculates the average value in a range of cells that 

meet the specified criteria. 

=AVERAGEIF(range,criteria,[average_range]) 

=AVERAGEIF(F

4:F8,"Yes",E4:E8

) 

09 DAYS Date & Time Returns the number of days between two dates =DAYS(D4,C4) 
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10 NOW Date & Time Returns the current system date and time =NOW() 

Numeric Functions 

As the name suggests, these functions operate on numeric data. The following table shows some 

of the common numeric functions. 

S/N FUNCTION CATEGORY DESCRIPTION USAGE 

1 ISNUMBER Information Returns True if the supplied value is numeric 

and False if it is not numeric 

=ISNUMBER(A3) 

2 RAND Math & Trig Generates a random number between 0 and 1 =RAND() 

3 ROUND Math & Trig Rounds off a decimal value to the specified 

number of decimal points 

=ROUND(3.14455,2) 

4 MEDIAN Statistical Returns the number in the middle of the set 

of given numbers 

=MEDIAN(3,4,5,2,5) 

5 PI Math & Trig Returns the value of Math Function PI(π) =PI() 

6 POWER Math & Trig Returns the result of a number raised to a 

power. POWER( number, power ) 

=POWER(2,4) 

7 MOD Math & Trig Returns the Remainder when you divide two 

numbers 

=MOD(10,3) 

8 ROMAN Math & Trig Converts a number to roman numerals =ROMAN(1984) 
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String functions 

These functions are used to manipulate text data. The following table shows 

some of the common string functions. 

S/N FUNCTION CATEGORY DESCRIPTION USAGE COMME

NT 

1 LEFT Text Returns a number of specified 

characters from the start (left-

hand side) of a string 

=LEFT("GURU99",4) Left 4 

Characters 

of 

"GURU99

" 

2 RIGHT Text Returns a number of specified 

characters from the end (right-

hand side) of a string 

=RIGHT("GURU99",

2) 

Right 2 

Characters 

of 

"GURU99

" 

3 MID Text Retrieves a number of 

characters from the middle of a 

string from a specified start 

position and length. =MID 

(text, start_num, num_chars) 

=MID("GURU99",2,3

) 

Retrieving 

Characters 

2 to 5 

4 ISTEXT Information Returns True if the supplied 

parameter is Text 

=ISTEXT(value) value - The 

value to 

check. 
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5 FIND Text Returns the starting position of 

a text string within another text 

string. This function is case-

sensitive. =FIND(find_text, 

within_text, [start_num]) 

=FIND("oo","Roofing

",1) 

Find oo in 

"Roofing", 

Result is 2 

6 REPLACE Text Replaces part of a string with 

another specified 

string. =REPLACE (old_text, 

start_num, num_chars, 

new_text) 

=REPLACE("Roofing

",2,2,"xx") 

Replace 

"oo" with 

"xx" 

Date Time Functions 

These functions are used to manipulate date values. The following table shows some of the 

common date functions 

S/N FUNCTION CATEGORY DESCRIPTION USAGE 

1 DATE Date & Time Returns the number that represents the date 

in excel code 

=DATE(2015,2,4

) 

2 DAYS Date & Time Find the number of days between two dates =DAYS(D6,C6) 

3 MONTH Date & Time Returns the month from a date value =MONTH("4/2/2

015") 

4 MINUTE Date & Time Returns the minutes from a time value =MINUTE("12:3

1") 

5 YEAR Date & Time Returns the year from a date value =YEAR("04/02/2

015") 
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GRAPHS AND CHARTS IN EXCEL 

Charts and graphs elevate your data by providing an easy-to-understand visualization of numeric 

values.  While the terms are often used interchangeably, they are slightly different. Graphs are 

the most basic way to represent data visually, and typically display data point values over a 

duration of time. Charts are a bit more complex, as they allow you to compare pieces of a data 

set relative to the other data in that set. Charts are also considered more visual than graphs, since 

they often take a different shape than a generic x- and y-axis. 

People often use charts and graphs in presentations to give management, client, or team members 

a quick snapshot into progress or results. You can create a chart or graph to represent nearly any 

kind of quantitative data — doing so will save you the time and frustration of poring through 

spreadsheets to find relationships and trends. 

It’s easy to create charts and graphs in Excel, especially since you can also store your data 

directly in an Excel Workbook, rather than importing data from another program. Excel also has 

a variety of preset chart and graph types so you can select one that best represents the data 

relationship(s) you want to highlight. 

How to Chart Data in Excel 

To generate a chart or graph in Excel, you must first provide Excel with data to pull from. In this 

section, we’ll show you how to chart data in Excel 2016. 

Step 1: Enter Data into a Worksheet 

1. Open Excel and select New Workbook. 

2. Enter the data you want to use to create a graph or chart. In this example, we’re 

comparing the profit of five different products from 2013 to 2017. Be sure to include 

labels for your columns and rows. Doing so enables you to translate the data into a chart 

or graph with clear axis labels. You can download this sample data below. 
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Step 2: Select Range to Create Chart or Graph from Workbook Data 

1. Highlight the cells that contain the data you want to use in your graph by clicking and 

dragging your mouse across the cells. 

2. Your cell range will now be highlighted in gray and you can select a chart type. 

 

How to Make a Chart in Excel 

Once you input your data and select the cell range, you’re ready to choose your chart type to 

display your data. In this example, we’ll create a clustered column chart from the data we used in 

the previous section. 

Step 1: Select Chart Type 

Once your data is highlighted in the Workbook, click the Insert tab on the top banner. About 

halfway across the toolbar is a section with several chart options. Excel provides Recommended 

Charts based on popularity, but you can click any of the dropdown menus to select a different 

template. 
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Step 2: Create Your Chart 

1. From the Insert tab, click the column chart icon and select Clustered Column. 

 

1. Excel will automatically create a clustered chart column from your selected data. The chart will 

appear in the center of your workbook. 

2. To name your chart, double click the Chart Title text in the chart and type a title. We’ll call this 

chart “Product Profit 2013 - 2017.” 

 

We’ll use this chart for the rest of the walkthrough. You can download this same chart to follow 

along. 

  



BBA-3rd semester (IT Tools for Business)                      www.sbs.ac.in 

 
 

 

 

There are two tabs on the toolbar that you will use to make adjustments to your chart: Chart 

Design and Format. Excel automatically applies design, layout, and format presets to charts and 

graphs, but you can add customization by exploring the tabs. Next, we’ll walk you through all 

the available adjustments in Chart Design. 

 

 

 

 

 

 

 



BBA-3rd semester (IT Tools for Business)                      www.sbs.ac.in 

 
 

 

Step 3: Add Chart Elements 

Adding chart elements to your chart or graph will enhance it by clarifying data or providing 

additional context. You can select a chart element by clicking on the Add Chart 

Element dropdown menu in the top left-hand corner (beneath the Home tab). 

 

 

How to Make a Graph in Excel 

Although graphs and charts are distinct, Excel groups all graphs under the charts categories 

listed in the previous sections. To create a graph or another chart type, follow the steps below 

and select the appropriate graph type. 

Select Range to Create a Graph from Workbook Data 

1. Highlight the cells that contain the data you want to use in your graph by clicking and 

dragging your mouse across the cells. 
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2. Your cell range will now be highlighted in gray.

 

3. Once the text is highlighted you can select a graph (which Excel refers to as chart). 

Click the Insert tab and click Recommended Charts on the toolbar. Then click the 

type of graph you wish to use. 
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Now you have a graph. To customize your graph, you can follow the same steps explained in 

the previous section. All functionality for creating a chart remains the same when creating a 

graph. 

How to Create a Table in Excel 

If you don’t need to make a data visualization, you can also create a table in Excel using pre-

existing data. There are two ways to format a data set as a table: 

 Manually: In this example, we manually added data and formatted as a table by 

including column and row names (products and years). 

 Use Excel’s Format as Table Preset: You can also input raw data (numbers without 

any column and row names). 

1. To format data as a table, click and drag your mouse across the cells with the data 

range, click the Home tab, and click the Format as Table drop-down menu on the 

toolbar.  

 

 

2. Click New Table Style… (You will also see an option to use PivotTables. This feature 

is outside the scope of this how-to, but the concept is explained in the following  
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3. Section).  

4. A dialogue box opens and you can choose which aspects of the selected range to 

include in your formatted table. Click the blue OK button.
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